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[bookmark: _Toc40343210]Introduction
[bookmark: _Toc40343211]Purpose of this Guide
With this guide, the Agency for Health Care Administration (AHCA) Florida Health Care Connections (FX) Program is establishing a single set of editorial standards for its deliverables, written content, and other artifacts in accordance with the FX Artifact Management Standards (AMS). These standards will ensure that all project areas have a consistent look and feel and are communicated in a common voice, while maintaining the integrity of FX branding. In addition, refer to Appendix A below to review and adhere to the FX Branding Standards and Identity Guidelines artifact for guidance with using Agency logos.
Apply the style guidelines presented in this guide when you author artifacts (i.e., MS Word Documents, PowerPoint slide decks, and other written materials) developed for or related to an FX Project. The goal is to standardize language and formatting to improve consistency and reduce quality assurance (QA) review cycle times. If you have questions regarding templates or formatting, please contact a member of the FX Enterprise Program Management Office (EPMO).
Note: Refer to the Table of Contents for a list of subjects for review and usability.



[bookmark: _Toc40343212]Style and Writing Guidelines
[bookmark: _Toc40343213]General Guidance for Artifact Development
All artifacts shall be developed in accordance with the FX Artifact Management Standards (AMS) and using the appropriate FX Program templates and general guidance as follows:
Use a fresh template to start development of an artifact.
Ensure use of Agency logos is in accordance with the FX Branding Standards and Identity Guidelines (see Appendix A below)
Each new Section shall start on a new page—this does not apply to subsections.
Abbreviations and Acronyms must be defined with first use in all artifacts.
Use one space between sentences and after punctuation.
Use italics or boldface in lieu of quotation marks for emphasis—use quotation marks for quotable text.
Use the cross-reference feature of MS Word for referring to exhibits, strategic topics, and other diagrams.
For the definition of an artifact, refer to the AMS (Section 3.1 Deliverables vs. Work Products Guidance). For additional guidance regarding any of the above, refer to the AMS and the remaining sections of this FX Program Style and Writing Guide (hereafter referred to as Style Guide).
[bookmark: _Toc40343214]FX Program Templates
The subsections below provide general guidance for accessing and using FX Program templates in accordance with the AMS, as well as using the pre-set template format styles, and DRAFT watermarks.
[bookmark: _Toc40343215]General
In accordance with the AMS, all artifacts shall be created using the FX Program templates as provided in the Templates folder in the FX Projects Repository (FXPR) for the item being authored (Florida Health Care Connections > Templates). This will ensure formatting and text styles are consistent. Refer to the AMS (Section 3.4 FX Program Templates Standard) and the Developing and/or Updating FX Templates process definition located in the FXPR (Florida Health Care Connections > Process Definitions > FX-NH-ProcDef-Template-(current version)).
Note: Never start developing a new artifact by re-using an existing artifact as doing so may cause formatting issues, plus the artifact may be a corrupted file.
[bookmark: _Toc40343216]How to Use a Template
Do not make any changes to an approved template. Below are the steps to follow once you have selected a template for artifact development:
Right click on the template name in the Templates folder 
From the list of options, click on Download—the downloaded template will be located at the bottom left of your screen (or go to the Downloads folder on your desktop and right click on the downloaded document and click New to open and then click on Enable Editing)
Click on the downloaded template to open the template in the supported application (e.g., MS Word)
Click on Enable Editing at the top in the yellow highlight
Now save this template prior to developing your artifact as follows:
Click on File (top left) then click on Save As and then This PC and enter the name of your artifact using the artifact naming convention and click Save
Note: When you are saving and naming your artifact from a template, the file extension automatically defaults to a MS Word Document (*.docx)
Now you may start developing your artifact and upload it to the appropriate folder in the FXPR.
[bookmark: _Toc40343217]Pre-set Template Format Styles
When you develop your artifact, do not change any artifact formatting. The FX Program templates are pre-set with standardized and approved format styles to select from for the type of template you select (i.e., from the Home ribbon command bar, see Home > Styles) as shown in Exhibit 2‑1: Styles Shown on Document Menu Bar below. Use the Styles arrows to view the variety of standardized styles to select from.
[image: ]
[bookmark: _Ref19707616][bookmark: _Toc40343353]Exhibit 2‑1: Styles Shown on Document Menu Bar
For more information, refer to the guidance in the AMS (Section 3.4 FX Program Templates Standard) and the Developing and/or Updating FX Templates process definition located in the FXPR (Florida Health Care Connections > Process Definitions > FX-NH-ProcDef-Template-(current version)). Refer to Appendix B Standard Font, Font Color, And Font Size Style Settings below for details regarding standard font styles. Note: FX projects may engage the FX EPMO for guidance on use of the appropriate template prior to artifact development.
[bookmark: _Toc40343218]DRAFT Watermark
In accordance with the AMS, all draft MS Word artifacts (to include deliverables) should have a DRAFT watermark, which will be removed once an artifact is finalized and versioned to 100. The DRAFT watermark only applies to MS Word artifacts and not MS Excel, MS PowerPoint, or other artifact formats. FX templates do not include a DRAFT watermark and you will need to add it to your artifact during initial artifact development. For how to add or remove a DRAFT watermark, refer to the Developing and/or Updating FX Templates process definition located in the FXPR (Florida Health Care Connections > Process Definitions > FX-NH-ProcDef-Template-(current version)).
Note: The DRAFT watermark does not apply when updating previously approved final artifacts, only to initial first draft of artifacts.
[bookmark: _Toc40343219]Specific Style Guidelines for Procurement Artifacts
When creating artifacts for a procurement that will become part of a solicitation (ITN), or an attachment to a future contract artifact, you must follow the style guidelines set forth in the three-page Agency for Health Care Administration (AHCA) Procurement Office Style Guide attached below. Be sure to partner with the SEAS Procurement Manager on all procurement artifacts being developed.


[bookmark: _Toc40343220]AHCA Guidelines
For further guidance, the Agency has provided the following link to their Style Guides, Templates, and Correspondence Manuals:
https://portal.ahca.myflorida.com/comm/Correspondence/Forms/AllItems.aspx
Note: In order to open the link above, AHCA Remote Desktop Access is required and you must be logged into the AHCA Portal.
[bookmark: _Toc40343221]AHCA Statewide Medicaid Managed Care (SMMC) Program Style Guide
The Statewide Medicaid Managed Care program has three program components and can either be referred to in its entirety or individual components can be discussed. In this style guide (embedded below) are the appropriate ways to use references to the program as a whole, and then to each of the three program components. These components are:
Managed Medical Assistance
Long-Term Care
Dental


[bookmark: _Toc40343222]Defining Terms and Acronyms
In accordance with the AMS, always spell out terms and acronyms with first use. After a term or acronym has been spelled out once, it does not need to be defined again. For example, Agency for Health Care Administration (AHCA or the Agency). Every instance thereafter should reference it as AHCA or the Agency.
Write out the full term before using stand-alone acronym references. For example, Florida Health Care Connections (FX) must appear in the artifact before stand-alone references to FX.
[bookmark: _Toc40343223]Commonly used Abbreviations and Acronyms
Refer to the FX Projects Glossary for abbreviations and acronyms, which is located in the FXPR (i.e., Florida Health Care Connections > Project Glossary). See Appendix C below to view a quick reference list of some of the more commonly used abbreviations and acronyms.
[bookmark: _Toc40343224]Proper Project References and Abbreviations
Use AHCA Florida Health Care Connections (FX) to refer to the overall multi-year, multi-project initiative to enhance both the provider and recipient experience, improve access to current healthcare data, and streamline communication of healthcare data between State of Florida agencies. (Formerly known as the Medicaid Enterprise System (MES)). Note: Any reference made to MES must ensure the acronym is first spelled out as Medicaid Enterprise System.
Use FX Project or FX projects to refer to an individual project or group of projects encompassed in FX.
Use the below project names and abbreviations to refer to specific projects within the FX Program.
Case Management Tracking (CMT)
Data Governance Implementation (DGI)
Enterprise Data Warehouse (EDW)
Enterprise Job Scheduler (EJS)
Integration Services and Integration Platform Design, Development, and Implementation (IS/IP DDI)
Provider Management Module Procurement (PMMP)
For guidance on projects not listed above, refer to the List of Projects in the FXPR (SEAS > SEAS Organization > Project Tracking > List of Projects) or ask the FX EPMO for assistance.
[bookmark: _Toc40343225]References to FX Contract Numbers
Refer to the Strategic Enterprise Advisory Services (SEAS) Contract Number as MED191. (Note: There is no dash between MED and 191.)
Refer to the Integration Services and Integration Platform Design, Development, and Implementation (IS/IP DDI) Contract Number as MED205.
For guidance on contracts not listed above, ask the FX EPMO for assistance.
[bookmark: _Toc40343226]Proper References to Vendor Providers and Roles
Refer to the vendor providers and Agency project team as follows:
The North Highland Team should be referred to as the SEAS Vendor.
NTT DATA should be referred to as the IV&V Vendor.
AHCA project team should be referred to as the FX Project Team.
Agency for Health Care Administration should be referred to as AHCA or the Agency. (Note: Always spell out the AHCA acronym with first use.)
The North Highland Company LLC should be referred to as North Highland.
NTT DATA State Health Consulting, LLC should be referred to as NTT DATA.
ProCom Consulting, Inc. should be referred to as ProCom.
Accenture LLP should be referred to as Accenture.
Provider of Integration Services and Integration Platform services should be referred to as the IS/IP Vendor. (Note: Always spell out the IS/IP acronym with first use.)
Provider for the Enterprise Data Warehouse should be referred to as the EDW Vendor. (Note: Always spell out the EDW acronym with first use.)
The team acting as the FX Enterprise Program Management Office that will provide overall scheduling, standards, templates, deliverable quality assurance, and artifact management support should be referred to as the FX EPMO.
For additional guidance, see the FX EPMO for assistance.
[bookmark: _Toc40343227]Preferred FX and MES Specific Terms and References
Do use the below FX and MES terms in the specified references:
AHCA FX Project Management – when submitting artifacts or deliverables to client
FX (or FX Program) – when referring to the overall multi-year, multi-project effort
FX Executive Governance or FX Program Governance – when referring to one of the FX Governance Committees
FX Portfolio – when referring to the collection of projects to transform the Medicaid Enterprise System
FX Project – when referring to a specific project included in the FX Portfolio
FX Projects Repository – when referring the collective body of information where artifacts are stored for FX projects
Medicaid Certification Life Cycle (MECL) – when referring to the approach used in planning, creating, testing, deploying, and maintaining the MMIS in order to comply with CMS certification requirements
Medicaid Certification Toolkit (MECT) – when referring to the body of information and checklists used to provide a consistent, detailed process to certify an MMIS and to help states prepare for the federally required certification review of a state’s MMIS
Medicaid Enterprise – when referring to the domain in which federal matching funds apply
Medicaid Enterprise System (MES) – when referring to the collection of business, data, services, technical processes, and systems within the Agency and touchpoints outside the Agency necessary for the administration of the Florida Medicaid Program
Medicaid Information Technology Architecture (MITA) – when referring to the initiative by the federal CMS intended to foster integrated business and IT transformation across the Medicaid Enterprise to improve the administration of the Medicaid Program
Medicaid Management Information System (MMIS) – when referring to a state’s Medicaid claims processing and information system that supports the operation of the Medicaid Program (Note: If Florida specific, use FMMIS)
MES System Change – when referring to any modification of a system functionality that is in the Medicaid Enterprise, including information and technical architecture
For more information, refer to Section 2.5.1 Commonly Used Abbreviations and Acronyms below, and can ask the FX EPMO for assistance.
Do not use the below terms:
FX Project Governance
FX Strategic Governance
MES Governance
MES Program Leadership Council
MES Project 
MES Projects Repository 
MES Strategic Leadership Council 
MES Vendor
SharePoint (only use as a reference to a tool type, e.g., Agency currently uses MS SharePoint and is referred to as the FX Projects Repository (FXPR).)
[bookmark: _Toc8198831][bookmark: _Toc8198931][bookmark: _Toc8199031][bookmark: _Toc10191655][bookmark: _Toc8198832][bookmark: _Toc8198932][bookmark: _Toc8199032][bookmark: _Toc10191656][bookmark: _Toc8198833][bookmark: _Toc8198933][bookmark: _Toc8199033][bookmark: _Toc10191657][bookmark: _Toc8198834][bookmark: _Toc8198934][bookmark: _Toc8199034][bookmark: _Toc10191658][bookmark: _Toc8198835][bookmark: _Toc8198935][bookmark: _Toc8199035][bookmark: _Toc10191659][bookmark: _Toc8198836][bookmark: _Toc8198936][bookmark: _Toc8199036][bookmark: _Toc10191660][bookmark: _Toc8198837][bookmark: _Toc8198937][bookmark: _Toc8199037][bookmark: _Toc10191661][bookmark: _Toc8198838][bookmark: _Toc8198938][bookmark: _Toc8199038][bookmark: _Toc10191662][bookmark: _Toc40343228]Reference to the FX Projects Glossary
In accordance with the AMS (Section 3.7 FX Projects Glossary Standard), do not add a glossary section containing a list of acronyms or terms to any artifact (i.e., deliverable or work product). Do point to the FX Projects Glossary (hereafter referred to as Glossary) located in the FXPR. Refer to AMS Section 3.7.1 Adding Reference to FX Projects Glossary in Artifacts for the suggested standard text to use.
Note: All unique terms used in an artifact, and not defined in the Glossary, must be submitted for inclusion in the Glossary during artifact development—refer to the Updating the FX Projects Glossary process definition located in the FXPR (Florida Health Care Connections > Process Definitions > FX-ProcDef-Updating-Project-Glossary-(current version)) for more information, along with the guidance provided in the AMS, to submit that term or acronym, including a full definition, after obtaining the appropriate approval.
[bookmark: _Toc40343229]References to SEAS Plans and Sub Plans (Standards)
When referring to a previously submitted/approved plan or sub plan (e.g., SEAS deliverables) in an artifact, be sure to reference it correctly and consistently throughout the artifact.
FX Artifact Management Standards (AMS)
FX OCM Plan
O-1: SEAS Management Plan (SMP)
FX EPMO Charter and Program Management Plan (O-2)
S-1: FX Governance Plan
S-2: FX Strategic Planning Training Program
S-3: FX Strategic Plan
S-4: Strategic Project Portfolio Management Plan
P-1: Revised MITA State Self-Assessment and Update Process
P-2: FX Project Management Standards
P-3: FX Project Management Toolkit
P-4: Medicaid Enterprise Certification Management Plan
T-1: Data Management Strategy
T-2: Information Architecture Documentation
T-3: Data Standards
T-4: Technical Management Strategy
T-5: Technical Architecture Documentation
T-6: Technology Standards
T-7: Design and Implementation Management Standards
T-8: Enterprise Data Security Plan
[bookmark: _Toc40343230]References to Meetings in Artifacts
When referring to a recurring meeting in an artifact, be sure to accurately name the meeting so that it matches the name listed in the associated FX Meeting Log. Also include the meeting’s frequency when including a meeting reference in an artifact.
For example:
FX Project schedules will be reviewed during the FX Program Weekly Schedule Review, a weekly meeting that occurs every Thursday at 2 p.m. EST.
[bookmark: _Toc40343231]FX Projects Repository (FXPR)
In accordance with the AMS, the FXPR is the Agency’s artifact repository, via Microsoft (MS) SharePoint. All FX Project artifacts shall be maintained on the FXPR, which is a document collaboration tool and artifact repository for use by all FX projects.
[bookmark: _Toc40343232]Rules for Opening and Editing Artifacts Stored on the FXPR
Once a new artifact has been created and uploaded to the FXPR, or you need to edit an existing artifact in the FXPR, follow the standards set forth in the AMS (Section 3.5 Editing an Artifact on the FXPR Standard). Remember to always open the artifact with Open in app, not Open in browser then make your updates.
[bookmark: _Toc40343233]Major and Minor Artifact Versions on the FXPR
When updating an artifact with the AutoSave capability activated, or each time an artifact is saved, the FXPR (MS SharePoint capability) generates a new minor version of the artifact as work on the artifact progresses—this creates the artifact’s version history. Once an artifact has been finalized in the FXPR, in accordance with the AMS, you can publish that final version, which will be reflected as a major version in the artifact’s version history.
The FXPR has a limitation to the number of minor versions that can be stored in the artifact’s version history before the save capability is disabled. The work-around for this is to publish the artifact, which creates a major version and enables the save capability to work again. The default for major versions is 500 and for minor versions is 511. Note: The 512th minor version of an artifact makes you publish a major version before proceeding (refer to Section 2.14.1 How to Publish a Major Artifact Version on the FXPR below).
[bookmark: _Toc40343234]How to Publish a Major Artifact Version on the FXPR
Follow these steps to publish an artifact (major version):
While the artifact is closed (i.e., not open and being edited), right click on the artifact
From the options listed click on More
From the options listed click on Publish
A Comments window will pop-up and you may enter any associated comments for the version you are publishing or leave blank, then click on Publish
Your artifact has now been published as a major version and reflected in the artifact’s version history—subsequent versions will be minor versions until another published version of the artifact
[bookmark: _Toc40343235]Artifact Naming Convention and Versioning Overview
Artifact naming conventions and versioning shall follow the standards set forth in the AMS. All FX Project artifacts shall use the standard naming convention to provide consistency in the way all project-related artifacts are named and must be named in line with the naming convention when uploaded to the FXPR. (For more information regarding the definition of an artifact, refer to AMS Section 3.1 Deliverables vs. Work Products Guidance.) The artifact naming standards applies to all users posting artifacts to the FXPR. The guidance provided in the AMS offers the standard naming conventions that should be used for all artifacts posted to the FXPR. Note: All artifacts are permanent products of the Agency and are not vendor owned.
[bookmark: _Hlk12436322]For more information regarding artifact naming conventions and examples—including naming convention with date and template naming convention—refer to AMS Section 3.2 Artifact Naming Standard. 
For more information regarding the versioning of artifacts—including versioning of artifacts for quarterly updates to approved artifacts—refer to AMS Section 3.3 Artifact Version Control Standard.
[bookmark: _Toc40343236]Standard Rules for Spacing
Each new section of an artifact shall start on a new page—this does not apply to subsections.
Enter one (1) space between sentences and after punctuation. Use one space between the period at the end of a sentence and the first letter of the next sentence. (Using two spaces after punctuation is an outdated writing method.)
Follow the standard rules for spacing below:
ONE space following a period (.) or a colon (:)[footnoteRef:2] [2:  This is contrary to the AHCA Correspondence Guide, 2019, which instructs to use two spaces. Both The Chicago Manual of Style and AP Stylebook recommend one space after periods and after colons.] 

ONE space following a comma (,) or semicolon (;)
ONE space on either side of a dash ( – )
NO space on either side of a hyphen (-)
NO space between initials of a single abbreviation, such as C.O.D., a.m., and p.m.
For more information, also refer to Section 5 Guide to Punctuation in this Style Guide.
[bookmark: _Toc40343237]Rules for Copy and Paste
Do not copy and paste large blocks of content from other artifacts. It is preferred that a reference pointing to the source artifact be made instead. This practice will alleviate the need to update multiple artifacts when content changes are made.
For text, ALWAYS use the copy/paste special feature and choose option A for Keep Text Only as shown by the red arrow in Exhibit 2‑2: Paste Options below – this is unformatted text and will adhere to the current format of the destination artifact you are pasting to (i.e., the new text will automatically be changed to the destination artifact’s style). To do this, which keeps formatting consistent when copying data from another artifact, first select the area to copy (i.e., highlight selection) and then press Ctrl C together for copy. Next, go to the artifact you want to paste the data into and highlight the area where you want the data to go, or highlight the area or word(s) you are replacing and right click. From the Paste Options, select icon A for Keep Text Only. The new text will automatically be changed to the destination artifact’s style. If you want to keep the original artifact’s formatting, then simply place your cursor where you want the text to be inserted and press Ctrl V together for paste and this will keep original format and not convert to the destination artifact’s formatting.
[image: ]
[bookmark: _Ref29462333][bookmark: _Toc40343354]Exhibit 2‑2: Paste Options
[bookmark: _Toc40343238]Copy/Paste Rules for Graphics
For graphics, once you have copied a graphic, paste that graphic using the Paste Special function as follows:
From the Home ribbon command bar, click on the Paste drop-down arrow as shown in Exhibit 2‑3: Location of Paste Function Drop-Down Arrow below
From the drop-down options click on the Paste Special… option
From the Paste As options, select Picture (Enhanced Metafile) and click OK as shown in Exhibit 2‑4: Paste As Options Window below
[image: ]
[bookmark: _Ref29459295][bookmark: _Toc40343355]Exhibit 2‑3: Location of Paste Function Drop-Down Arrow
[image: ]
[bookmark: _Ref29460287][bookmark: _Toc40343356]Exhibit 2‑4: Paste As Options Window
Note: All tables and graphics shall be titled as exhibits and cross-referenced in artifacts as described in Section 2.19 Tables and Exhibits and 2.19.1 Cross-Referencing Exhibits below.
[bookmark: _Toc40343239]Tables and Exhibits
Verify that text styles within tables are consistent according to the style and format set for the template used.
Standard table formatting is as follows:
Table Column Header(s) – use bold style font Arial size 10 and custom blue font color as shown in Exhibit 2‑5: Table Header Custom Font Color below for table/column titles
[image: ]
[bookmark: _Ref29542562][bookmark: _Toc40343357]Exhibit 2‑5: Table Header Custom Font Color
Table Borders – use custom green color borders with width 1 ½ pt. for above and below the table header and for the bottom table border, as shown in Exhibit 2‑6: Table Border Custom Font Color and Exhibit 2‑7: Green Table Borders below
[image: ]
[bookmark: _Ref29542939][bookmark: _Toc40343358]Exhibit 2‑6: Table Border Custom Font Color
[image: ]
[bookmark: _Ref29542956][bookmark: _Toc40343359]Exhibit 2‑7: Green Table Borders
Interior Table Borders – 
Use black color font in Arial size 9 for all text (except column titles) for data within a table
Use custom gray color borders with width 1 ½ pt. for interior table borders—vertical and horizontal—as shown in Exhibit 2‑8: Interior Table Borders Custom Font Color and Exhibit 2‑9: Gray Interior Table Borders below
[image: ]
[bookmark: _Ref29544350][bookmark: _Toc40343360]Exhibit 2‑8: Interior Table Borders Custom Font Color
[image: ]
[bookmark: _Ref29544364][bookmark: _Toc40343361]Exhibit 2‑9: Gray Interior Table Borders
Title all exhibits to include the associated section number followed by the chronological number of the exhibit within the section itself. For example, for a third exhibit in Section 2 titled Team Summary, you would title the exhibit as Exhibit 2-3: Team Summary using bold custom green font as shown in Exhibit 2‑10: Custom Font Color for Exhibit Titles below and using auto-numbers (field codes) as described in the next bullet.
[image: ]
[bookmark: _Ref29545151][bookmark: _Toc40343362]Exhibit 2‑10: Custom Font Color for Exhibit Titles
Verify the title below every exhibit to ensure the numbers are sequential in each section of the artifact. To do this, right click on each number in the exhibit title and select Update Field to make sure that the auto-numbers in the title are updated. For the first occurrence of an exhibit in a section, use the \r 1 suffix in the field code for the exhibit number (not the associated section number) to start/restart the exhibit count to 1 as shown in the examples below.
Example of an exhibit caption with auto-numbering field codes for the first exhibit in a section:
Exhibit {StyleRef Deliverable-H1}-{SEQ Exhibit \* ARABIC \r 1 }: Data Management Framework
Example of an exhibit caption for subsequent exhibits in a section: 
Exhibit {StyleRef Deliverable-H1}-{SEQ Exhibit \* ARABIC }: Common Data Architecture
Note: When editing and adding exhibits into an artifact, it is much easier to copy and paste the auto-numbering field codes from an existing exhibit within an artifact, or from a template, rather than manually adding the auto-numbering field codes as shown above.
Make sure references to exhibits, when noted in paragraphs, are properly cross-referenced (see Section 2.19.1 Cross-Referencing Exhibits below), put in bold font, and match the numbering beneath the respective exhibits. Exhibit numbering often gets out of sync as edits progress.
When exhibits are correctly titled, as described above, the Table of Exhibits will populate correctly below the Table of Contents.
Tips – (1) If an exhibit title does not populate the Table of Exhibits, it is most likely due to a manually entered exhibit number(s) and not using the auto-numbering field codes; and (2) when updating existing exhibit titles and auto-numbers while using the Track Changes capability, be sure to make these updates while in No Markup display for review and not in All Markup.
[bookmark: _Toc40343240]Cross-Referencing Exhibits
All tables and graphics shall be titled as exhibits and cross-referenced in artifacts, as done throughout this Style Guide (see Section 2.19 Tables and Exhibits above). Done properly, exhibits will be reflected in the Table of Exhibits, which is located below the artifact’s Table of Contents. Below are the steps to follow for adding a cross-reference:
Place your cursor where you want the cross-reference to be inserted in your artifact
From the Home ribbon command bar, select References then from Captions click on Cross-reference as shown in Exhibit 2‑11: Location of References and Cross-Reference below:
[image: ]
[bookmark: _Ref29465311][bookmark: _Toc40343363]Exhibit 2‑11: Location of References and Cross-Reference
The Cross-reference window will open (see Exhibit 2‑12: Cross-Reference Window below) and you will make the following selections:
[image: ]
[bookmark: _Ref29465961][bookmark: _Toc40343364]Exhibit 2‑12: Cross-Reference Window
From the Reference type drop-down select Exhibit (see note below if Exhibit is not in the drop-down options)
From the Insert reference to drop-down select Entire caption
Check the Insert as hyperlink box if not already checked by default
From the For which caption drop-down click on the exhibit title you want to cross-reference and then click on Insert then click on Close (must be sure to click on Close to finish inserting the cross-reference)
Your cross-reference has now been added and when you click on the cross-reference you can see that is highlighted
Now highlight and bold the inserted cross-reference to finish (as done throughout this Style Guide)
Note: If Exhibit is not listed as a drop-down option to select for Reference type, follow the steps below to add:
From the Home ribbon command bar, select References then from Captions click on Insert Caption as shown in Exhibit 2‑13: Location of References and Insert Caption below:
[image: ]
[bookmark: _Ref29469419][bookmark: _Toc40343365]Exhibit 2‑13: Location of References and Insert Caption
The default Caption window will open (see Exhibit 2‑14: Default Caption Window below) and you will make the following selections:
[image: ]
[bookmark: _Ref29471953][bookmark: _Toc40343366]Exhibit 2‑14: Default Caption Window
To add Exhibit, click on New Label… and the New Label window will open as shown in Exhibit 2‑15: New Label Window below
[image: ]
[bookmark: _Ref29472192][bookmark: _Toc40343367]Exhibit 2‑15: New Label Window
Now type in the word Exhibit in the Label text box as shown above in the New Label window and click OK and then click OK again
The Exhibit label has been added and you can now cross-reference exhibits as explained in Section 2.19.1 Cross-Referencing Exhibits above
[bookmark: _Toc40343241]How to Keep Exhibit Graphics and Exhibit Captions Together
When artifacts are developed or updated, often an exhibit’s graphic and associated exhibit caption may get split between two pages. It is preferred that exhibits and associated exhibit captions stay together on the same page. To do this, follow the steps below:
First, select/highlight both the exhibit graphic and the associated exhibit caption
From the Home ribbon command bar, click on the Paragraph drop-down arrow as shown in Exhibit 2‑16: Location of Paragraph Drop-Down Arrow below:
[image: ]
[bookmark: _Ref30761953][bookmark: _Toc40343368]Exhibit 2‑16: Location of Paragraph Drop-Down Arrow
From the Paragraph options window, select the Line and Page Breaks tab and check both the Keep with next and Keep lines together checkboxes and then click OK to finish, as shown in Exhibit 2‑17: Paragraph Options Window below:
[image: ]
[bookmark: _Ref30763582][bookmark: _Toc40343369]Exhibit 2‑17: Paragraph Options Window
Now your exhibit graphic and corresponding exhibit caption will stay together on the same page
Note: These steps can also be used to keep selected text together.
[bookmark: _Toc40343242]Bullets
Make bullet points consistent in structure (format) for each bulleted list in an artifact and in accordance with the pre-set standardized format styles as noted in Section 2.2.3 Pre-set Template Format Styles above. In addition, make bulleted lists either all sentences or fragments within a unique bulleted list. Refer to Exhibit 2‑18: Examples of Bullet Points and Use of Periods below.
Punctuate bullets consistently. That is, if one bullet ends with a period (full stop), end all with a period, following these rules:
If all bullets are sentences, end each one with a period (full stop). (Refer to Section 5.9 Periods (.) below.)
If all bullets are phrases or fragments, use no ending punctuation.
Avoid ending bullet points with a comma (,) or semicolon (;) and do not add the words and/or before the last bullet in a list, as this style is obsolete. 
Avoid making bullet points so long that they look like paragraphs. Three lines is a reasonable maximum length.
Avoid using transition words and phrases such as secondly or another point. Linking phrases is unnecessary and slows readers down. 
List assumptions in each tab as bullets.
	Bullet Points as Complete Sentences
	Bullet Points as Fragments

	The following tips can help prevent wildfires:
· Check the weather daily and don't burn on windy days or when the humidity is below 30 percent. Refer to Burn Ban 411 to see if your county is under a burn ban.
· Never leave a fire unattended, and make sure it is completely out before leaving. Let the wood burn down into ash and after fire has cooled down some, pour water over until the sizzling sounds are completely silenced.
· Keep a shovel and water handy in case a small fire starts to escape containment. Always check your surroundings prior to leaving the area.
	When visiting a U-pick farm, be sure to bring:
· A hat
· Sunscreen
· Containers for picking


[bookmark: _Ref29372946][bookmark: _Ref29473064][bookmark: _Ref29552899][bookmark: _Toc40343370]Exhibit 2‑18: Examples of Bullet Points and Use of Periods
[bookmark: _Toc40343243]Footnotes
Footnotes should only express a single idea.
If the footnote is longer than a few sentences, then the information should be put into an appendix
The body of the footnote should be Arial font size 10
When using footnotes in an artifact, ensure that the citation numbers are in sequential order and that the footnotes appear at the bottom of the same page they are referenced
For more information, follow the guidelines in The Chicago Manual of Style, 17th Edition: https://research.wou.edu/c.php?g=551307&p=3785233
[bookmark: _Toc40343244]How to Insert a Footnote
Follow the steps below for how to insert a footnote into an MS Word artifact:
Click where you want to add a footnote by either placing your cursor at the end of the word or highlight the word (be sure you do not also highlight any space after the word)
From the Home ribbon command bar, click on References and then click on Insert Footnote, as shown in Exhibit 2‑19: Home Ribbon Command Bar for Insert Footnote below
[image: ]
[bookmark: _Ref31274235][bookmark: _Toc40343371]Exhibit 2‑19: Home Ribbon Command Bar for Insert Footnote
MS Word inserts a footnote citation number in your text and adds the footnote mark at the bottom of the same page—type the footnote text and double-click on the footnote citation number to return to your place in the artifact
[bookmark: _Toc40343245]Links vs. Embedded Artifacts
In accordance with the AMS, avoid the use of embedded links (links contained within text) within an artifact—especially since links are easily broken when an artifact location gets changed. Best not to embed links in artifacts, except for links to websites. Refer to the AMS (Section 6.2.1 Referencing External Sources) for more information and guidance.
[bookmark: _Toc40343246]How to Embed an Artifact
An embedded artifact can be any document type (e.g., MS Word, Excel, Visio, PDF, etc.) to be put in an MS Word artifact. Be mindful that if you do embed an artifact, in lieu of a breadcrumb path, the embedded artifact may become archaic when the source artifact is updated. Follow the steps below for how to embed an artifact.
Click in the artifact (place your cursor) where you want to embed an artifact within that document.
Note: This process is not like inserting a link and cannot be done similar to a link where you can highlight a word and insert a link—embedding an artifact is a different approach and actually inserts the artifact within a document so that when you double click on the icon of the embedded artifact, the artifact will open.
From the toolbar, click on Insert (located next to Home).
From the Text command, click on the Object drop-down arrow and then select Object.
From the Object window, click on Create from File.
Use the Browse… button to select the artifact you want to embed.
Check the Display as icon box and do not click on OK yet (see Exhibit 2‑20: Object Window / Display as Icon Box below).
Note: Do not check the Link to file box as it will insert the whole artifact as text into your document and not as an icon.
[image: ]
[bookmark: _Ref18493286][bookmark: _Toc18932940][bookmark: _Toc40343372]Exhibit 2‑20: Object Window / Display as Icon Box
Next, as shown in Exhibit 2‑21: Object Window / Caption Embedded Item below, click on the Change Icon… button and enter a short name/title that will caption your embedded item icon.
Now click OK and click on OK again.
[image: ]	[image: ]
[bookmark: _Ref18497373][bookmark: _Toc18932941][bookmark: _Toc40343373]Exhibit 2‑21: Object Window / Caption Embedded Item
Now your artifact has been embedded. (See Exhibit 2‑22: Example of an Embedded Word Artifact below for what the icon of an embedded artifact looks like and note it is only a picture and will not open.)
[image: ]
[bookmark: _Ref18496755][bookmark: _Toc18932942][bookmark: _Ref29373098][bookmark: _Toc40343374]Exhibit 2‑22: Example of an Embedded Word Artifact
To open the embedded artifact, double-click on the icon. Then to close, click the X at the top right. Note: Always open the embedded artifact to ensure that it works and if it does not, follow the next step below to remove it and then try again using the steps above.
If you made an error embedding or captioning, just right click on the icon and click Cut to delete and then you can start over.
[bookmark: _Toc40343247]How to Link an Artifact Within the Body of an Email
Adding a link to an artifact located in the FXPR is preferred over sending a hard copy of an artifact via email. To link an artifact, follow the steps below:
Locate the artifact in FXPR you want to link and right click on the artifact name, which opens an options window and click on Copy link, as shown below in Exhibit 2‑23: Example of Copy Link Option, which opens the Link Copied window shown in Exhibit 2‑24: Copy Button and URL Copied Example below
[image: ]
[bookmark: _Ref30683238][bookmark: _Toc40343375]Exhibit 2‑23: Example of Copy Link Option
[image: ]Click on the blue Copy button, which highlights and copies the document’s web address (URL), as show below in Exhibit 2‑24: Copy Button and URL Copied Example
[bookmark: _Ref30684390][bookmark: _Toc40343376][image: ]Exhibit 2‑24: Copy Button and URL Copied Example
In the body of your email, use your cursor to highlight over the word(s) where you want the copied link to be applied and right click on that word(s) (sample email shown below shows the word link highlighted), which opens an options window then click on the Link option as shown in Exhibit 2‑25: Example of Outlook Email Link Option below
[image: ]
[bookmark: _Ref30685365][bookmark: _Toc40343377]Exhibit 2‑25: Example of Outlook Email Link Option
Once you click on the Link option, the Insert Hyperlink window opens, as shown in Exhibit 2‑26: Insert Hyperlink Window – Address Box below
Place your cursor in the Address: box and paste (i.e., Ctrl + V) the copied web address into the Address: box and click on OK (see Exhibit 2‑26: Insert Hyperlink Window – Address Box below)
[image: ]
[bookmark: _Ref30686936][bookmark: _Toc40343378]Exhibit 2‑26: Insert Hyperlink Window – Address Box
Now your artifact has been successfully linked in your email, as indicated by the blue font and underline of the word you originally highlighted (e.g., link) in the email
To open the link in the email, use your cursor to hover over the linked word and click on it to open the artifact
[bookmark: _Toc40343248]Rules for Using I.E. and E.G.
I.e. and e.g. are abbreviations for Latin terms. While their usage is similar, they are not interchangeable, and they are used differently in sentences. It is recommended that use of i.e. and e.g. be limited. Apply the following rules for when to use i.e. and e.g.:
I.e. is the abbreviation for id est and means in other words.
E.g. stands for exempli gratia and means for example.
Each letter in the abbreviation is followed by a period.
I.e. and e.g. do not need to be italicized.
I.e. and e.g. are always followed by a comma and followed by the example or statement.
Note: When writing either abbreviation, use the following industry standard rules:
The Chicago Manual of Style “prefers to confine the abbreviations i.e. and e.g. to parentheses or notes, where they are followed by a comma.”
According to the Associated Press (AP) Stylebook, both i.e. and e.g. are “always followed by a comma.”
[bookmark: _Toc40343249]Correct Abbreviation for the Word Continued
Spell out the word continued whenever possible. According to The Chicago Manual of Style, the abbreviation for continued is cont. Put a period after the abbreviated word and within parenthesis. (Example use in a title: Lessons Learned (cont.))
[bookmark: _Toc40343250]Writing References to Numbers
The associated subsections below provide general guidance for how to properly write any references using numbers when drafting or updating non-procurement artifacts. Refer to Section 2.3 Specific Style Guidelines for Procurement Artifacts above for artifacts that will become part of a solicitation (ITN). Also refer to the guidance in Section 2.26 Writing Numbers for Procurement/Contract Artifacts below.
[bookmark: _Toc40343251]General Writing of Numbers
In general, spell out numbers zero through nine in text. Use numbers for 10 and greater. These guidelines apply to numbers that stand alone and numbers in a series. (Examples: There are three programs within the Agency. There are 19 services with the program.)
[bookmark: _Toc40343252]Ordinals
Ordinals are numbers used to indicate order (e.g., first, second, third, etc.). Spell out first through ninth (for numbers 1-9). Starting with the number 10, use numbers with two letters (i.e., 10th, 20th, 31st, 23rd, 42nd, etc.).
[bookmark: _Toc40343253]Numbers Beginning a Sentence
Spell out any number that begins a sentence. Spell out two or more related numbers if the first word in the sentence is a number. (Example: Forty to fifty percent of Floridians think crime is the state’s worst problem.)
[bookmark: _Toc40343254]Number Abbreviation (No.) or Number Symbol (#)
The abbreviation or symbol for number should not be used in artifacts when a descriptive word appears before a figure. (Example: Administrative Policy and Procedure 1-17; page 12.)
[bookmark: _Toc40343255]Numbers with Four Digits or More
For numbers with four digits or more, use a comma every three decimal places. Exceptions include a policy, contract, check, street, room, and page numbers. (Examples: 15,000 keystrokes; Check 34567.)
[bookmark: _Toc40343256]Decimals
Use numbers to indicate decimals (Example: 3.405). Do not use the written form of decimals (e.g., in written form 3.405 is three and four hundred five thousandths).
[bookmark: _Toc40343257]Fractions
In text (unless you’re writing a recipe), spell out amounts less than one. Use hyphens between the words. (Examples: two-thirds, four-fifths, etc.) Use figures for precise amounts larger than one. Convert to decimals whenever practical.
[bookmark: _Toc40343258]Percentages
Use figures to express percentages. (Example: There was a 5 percent increase in sales.)
For amounts less than 1 percent, precede the decimal with a zero. (Example: The cost of living rose 0.3 percent.)
Write out the word percent in running text. Don’t use the percent (%) symbol. However, the symbol can be used when percentages are being shown in charts, graphs, or tables.
[bookmark: _Toc40343259]Millions, Billions, Trillions
To make numbers of a million and above easier to read, repeat the word million (billion, etc.) with each figure to also avoid misunderstanding. (Examples: A population of 1.5 billion. The social service needs range from $5 million to $8 million.) Note: Also use the dollar sign ($) in front of both the first and second amount.
[bookmark: _Toc40343260]Money
In accordance with the examples shown in Exhibit 2‑27: How to Write Specific Dollar Amounts below, use figures and the dollar ($) sign in all cases except casual references or amounts without a figure. To show specific amounts, use the decimal system (up to two places). For whole dollar amounts, do not use the decimal point and two zeroes. Note: Always use more than or less than when referring to numbers—do not user over or under.
	Write
	Do Not Write

	$1
	$1.00 or $1 dollar

	$1.59
	A dollar fifty-nine

	$1.50
	$1.5

	$10
	$10.00

	$100
	$100.00

	$1 million
	One million dollars or $1,000,000

	$1.6 million
	$1,600,000 or $1,600,000.00


[bookmark: _Toc511913852][bookmark: _Toc511913884][bookmark: _Ref34726320][bookmark: _Toc40343379]Exhibit 2‑27: How to Write Specific Dollar Amounts
[bookmark: _Toc40343261]Distance
Always use figures to indicate distance. (Example: I ran 5 miles this morning.)
[bookmark: _Toc40343262]Duration
Spell out numbers one through nine. Use figures for 10 and above. (Examples: She was gone for two hours. I work a nine-hour day. I’ll call you back in five minutes. The cake needs to bake for 25 minutes.)
[bookmark: _Toc40343263]Time of Day
In general, use figures except for noon and midnight. Use a colon to separate hours from minutes, but do not use :00 in running text. Refer to Exhibit 2‑28: Writing Examples for Time of Day below for examples.
Use an en-dash, which is shorter than the em-dash and longer than a hyphen, to indicate a span of time. The en-dash is similar to using the words to, through, and from. Refer to Section 5 Guide to Punctuation for more information regarding hyphens, dashes, en-dashes, and em-dashes.
a.m.
Lowercase; use periods. Do not use :00 with time of day in running text
p.m.
Lowercase; use periods. Do not use :00 with time of day in running text
	[bookmark: _Ref407034964][bookmark: _Toc408070070]Write
	Do Not Write

	11 a.m. – 1:30 p.m.
	11:00 am-1:30 pm

	10 – 11 a.m.
	10:00 am - 11:00 am

	1:30 p.m. – 2 p.m.
	1:30 PM - 2:00 PM

	11:30 a.m. – noon
	11:30 am - 12:00 pm


[bookmark: _Ref30684363][bookmark: _Toc40343380]Exhibit 2‑28: Writing Examples for Time of Day
[bookmark: _Toc40343264]Decades
When referring to decades, express decades as four and do not use an apostrophe to denote plural decades. (Example-Correct: 1990s. Examples-Incorrect: 1990’s or the ‘90s)
[bookmark: _Toc40343265]Dates
Use figures, but do not use the ordinal form of numbers. In other words, do not include -st, -nd, -rd, or –th. (Examples: October 16, not October 16th; November 24, not November 24th. My baby was born on May 5. Christmas is celebrated on December 25.)
Dates and Commas
If a sentence refers to a month, day, and year, set off the year with commas. (Example: The contract was signed on September 27, 2017.)
If a sentence includes only a month and a year, do not set off the year with commas. (Example: The program launched in October 2012.)
Abbreviations of Months
When a month is used with a specific date in running text, spell out all months. Spell out all the months when using alone or with the year only. (Examples: The exam is scheduled for October 16. She was born on May 9. December is a busy month. I have been with the department since September 2004.)
[bookmark: _Toc8047497][bookmark: _Toc8131629][bookmark: _Toc8131715][bookmark: _Toc8198869][bookmark: _Toc8198969][bookmark: _Toc8199069][bookmark: _Toc10191694][bookmark: _Toc40343266]Writing Numbers for Procurement/Contract Artifacts
For Procurement/Contract artifacts all numbers should be written out. Follow the examples below:
Return within two (2) months…
Hundreds and thousands will be used…
Percentages (Example: Ninety-five percent (95%) of the task…)
For more information specific for procurement artifacts, see Section 2.3 Specific Style Guidelines for Procurement Artifacts above.
[bookmark: _Toc40343267]Business vs. Calendar Days
Must distinguish between business and calendar days unless day is defined in the scope definition. (Example: Within fifteen (15) calendar days of completion.)
[bookmark: _Toc40343268]How to Write and Reference Acts, Codes, Federal Regulations, Laws, Rules, and Statutes
Use the guidance below and in the following subsections for how to write and reference a variety of acts, codes, Federal Regulations, laws, rules, and statutes in accordance with CMS, the Office of Policy and Budget Style Guide, and The Bluebook: A Uniform System of Citation (18th edition).
[bookmark: _Hlk31018969]The National Provider Identifier (NPI) Standard is a Health Insurance Portability and Accountability Act (HIPAA) Administrative Simplification Standard
HIPAA – is the acronym for the Health Insurance Portability and Accountability Act that was passed by Congress in 1996 (a.k.a., Health Insurance Portability and Accountability Act of 1996 (HIPAA))
Code of Federal Regulations (CFR) – see examples for citing below:
When citing the first reference use: Section 45 of the Code of Federal Regulations (CFR), Part 162
Thereafter cite as: 45 CFR, Part 162; 45 CFR 147.145(a); 29 CFR 2590.715-2715; or 42 CFR § 403.902
Federal Register (FR) – see example for citing below:
77 FR 8668
Public Health Service Act (PHS Act) – see examples for citing below:
PHS Act section 2715(b)(3)(G)
PHS Act section 2707
Florida Administrative Register (FAR) – the FAR is a daily publication containing proposed rules and notices of the state agencies and other government entities of Florida.
Administrative Procedure Act (APA) – the APA governs the process by which federal agencies develop and issue regulations, as well as addresses other agency actions such as issuance of policy statements, licenses, and permits.
[bookmark: _Toc40343269]Writing Florida Statutes (F.S.)
Always write out Florida Statutes on first reference in running text and italicized in all uses when spelled out. In subsequent references, use the abbreviation F.S. When citing a specific chapter, capitalize Chapter. When citing a section or sections of the statutes, the word section is in lowercase. In addition, if using the section symbol (§) in lieu of the word section, there is always a space before and after the section symbol.
The Division of Licensing regulates private security, private investigative, and recovery services in accordance with Chapter 493, Florida Statutes (F.S.). It issues concealed weapon licenses in accordance with section 790.06, F.S.
Only § 216.011(1)(k), Florida Statutes, provides a definition of disbursement.
Agency rulemaking is governed by Chapter 120, F.S., the Administrative Procedure Act. Rules are published in the Florida Administrative Code (F.A.C).
Note: When referencing F.S. chapters, do not include section numbers (e.g., Chapter 493, not Chapter 493.23); and when referencing F.S. sections, include both a chapter and section number (e.g., section 790.06, F.S.)
[bookmark: _Toc40343270]Writing Florida Administrative Code (F.A.C.)
Write out Florida Administrative Code on first reference in text and use the abbreviation F.A.C. in subsequent references. (Example: The department’s rules are found in Chapter 1C of the Florida Administrative Code (F.A.C.))
[bookmark: _Toc40343271]References to Department of Management Services (DMS) – Formerly AST
Effective July 1, 2019, the Agency for State Technology (AST) was absorbed by the Department of Management Services (DMS). Refer to Decision #162 in the Decision Log (located in the FXPR at SEAS Organization > Project Tracking > Decision Log) for guidance referring to DMS and the associated Florida Administrative Rule updates.
[bookmark: _Toc40343272]How to Add the Section Symbol (§) and Other Symbols in MS Word Artifacts
Follow the steps below to add a symbol (e.g., section symbol (§), degree symbol (°), copyright symbol (©), etc.) into an MS Word artifact:
From the Home ribbon command bar, click on Insert and then click on the Symbols drop-down arrow as shown in Exhibit 2‑29: Symbols Drop-down Arrow below
[image: ]
[bookmark: _Ref31026425][bookmark: _Toc40343381]Exhibit 2‑29: Symbols Drop-down Arrow
From the Symbols drop-down arrow options, click on the Symbols drop-down arrow option to open the Symbols window and click on the symbol of your choosing to add to your artifact
If the symbol you want does not display in the Symbols window, then click on the More Symbols… option as shown in Exhibit 2‑30: More Symbols Option below
[image: ]
[bookmark: _Ref31027423][bookmark: _Toc40343382]Exhibit 2‑30: More Symbols Option
This opens the Symbol window and you can select either the Symbols or Special Characters tab
Now use the up/down arrows to scroll through the symbol options to select from
Click on your preferred symbol to select it, then click on Insert and then click Close to add your symbol, as shown in Exhibit 2‑31: Symbol Window below
[image: ]
[bookmark: _Ref31029297][bookmark: _Toc40343383]Exhibit 2‑31: Symbol Window








[bookmark: _Toc40343273]Capitalization
[bookmark: _Toc7770245][bookmark: _Toc7772393][bookmark: _Toc7772697][bookmark: _Toc7793696][bookmark: _Toc8028740][bookmark: _Toc8030300][bookmark: _Toc8036851][bookmark: _Toc8036937][bookmark: _Toc8041388][bookmark: _Toc8043985][bookmark: _Toc8047501][bookmark: _Toc8047736][bookmark: _Toc8047913][bookmark: _Toc8131633][bookmark: _Toc8131719][bookmark: _Toc8198724][bookmark: _Toc8198873][bookmark: _Toc8198973][bookmark: _Toc8199073][bookmark: _Toc8199365][bookmark: _Toc8206574][bookmark: _Toc8312166][bookmark: _Toc8384902][bookmark: _Toc8396832][bookmark: _Toc8658787][bookmark: _Toc10191698][bookmark: _Toc17707109][bookmark: _Toc40343274]Rules for Capitalizing State
Apply these rules for capitalizing state:
Lowercase the word state when it is used simply as an adjective to specify the level of jurisdiction. (Examples: I have worked in state government for 10 years. Many states have implemented a COTS solution.)
Capitalize state when referring to a specific state entity by name (i.e., proper noun). (Examples: I visited Myakka State Forest last weekend. I would like to visit Blackwater River State Forest this year. I attended Florida State University.) 
Do not capitalize the word state when it stands alone and not part of the proper noun State of Florida. (Example: Education is a state priority.) 
[bookmark: _Toc40343275]General Rules for Capitalization
Board – capitalize as part of a full official board name; otherwise, lowercase.
Cabinet – capitalize when part of government body.
Conference – capitalize as part of a full official name; otherwise, lowercase. (Examples: Alternative Enterprises Conference; the conference.)
Email – always lowercase and always one word; no hyphen or dash (i.e., email).
End-user – lowercase and hyphenated in all uses.
Federal – lowercase in most instances (e.g., the federal government). Refer to Section 3.2.3 Federal for more information. 
Go-Live – both words initial cap and hyphenated.
ID – all caps, no periods.
IT – all caps, no periods.
Java – always initial cap.
Page – do not capitalize page number references (i.e., see page 32).
Project/Program – do not capitalize for general use (e.g., The project/program is doing well.). Only capitalize when referring to a specific project/program by name (e.g., FX Project). If project/program is plural, then lowercase (e.g., All FX projects will follow standards.).
Round-robin – always lowercase; always hyphenated (i.e., round-robin).
Section – do not capitalize general references to a section of an artifact (e.g., This section has many components.). Only capitalize when referring to a specific section in an artifact (e.g., see Section 3.2 General Rules for Capitalization for more information).
Team – do not capitalize for general team references (e.g., The team won the game.). Only capitalize when referring to a specific named team (e.g., FX Team, OCM Team, etc.).
Website – lowercase and one word.
[bookmark: _Toc40343276]Proper Nouns/Proper Adjectives
Proper nouns name of a specific person, place, thing, or idea and should be capitalized. (Examples: Disney World; Florida State University; University of Florida) Adjectives derived from compass points and nouns designating the inhabitants of some geographical regions are capitalized. (Examples: A Southern accent; Northerners are visiting the Gulf Coast.)
[bookmark: _Toc40343277]Government and Administration
The terms administration and government are capitalized only when they are applicable to a government in power. (Examples: The Bailey Administration announced a new oil and gas program. Policies vary from one administration to another. The United States Government is respected by many other nations.)
[bookmark: _Toc40343278]Federal
Capitalize federal when referring to the architectural style or when the word is used as part of a formal name. (Examples: All Federal-style houses are noted for their simplicity and symmetry. The Federal Bureau of Investigation; the Federal Communications Commission; the federal government; federal court, and federal agents.)
[bookmark: _Toc40343279]Legislature
Capitalize legislature when it is preceded by the name of a state. Capitalize even when the state name is dropped but the reference is specifically to that state’s legislature. Lowercase the word when it is used generically or in the plural form. (Examples: He is a member of the Florida Legislature. The Legislature took a break last week for Passover and Easter. The Georgia and Florida legislatures are considering the amendment. No legislature has approved the amendment yet.)
[bookmark: _Toc40343280]National
The term national is capitalized when it precedes a capitalized word or when it forms a part of a specific name or title; however, it is lowercased when used as a descriptive word or as a noun. (Examples: I’m a member of the National Wildlife Federation. He’s doing this in the interest of national security. Foreign nationals must present a valid passport.)
[bookmark: _Toc40343281]Laws, Bills, Treaties
Capitalize formal titles of acts, laws, bills, and treaties, but do not capitalize common noun elements that stand alone in place of the full name.
	Write
	Do Not Write

	Airline Deregulation Act; the act
	the Act

	Public Law 480; the law
	the Law

	First Amendment; the amendment
	the Amendment


[bookmark: _Toc40343384]Exhibit 3‑1: Proper Noun and Common Noun Capitalization
[bookmark: _Toc40343282]Nationalities and Languages
Capitalize nationalities and languages. (Examples: Canadians; Vietnamese; the English language.)
[bookmark: _Toc40343283]Places
City – capitalize city when it is an essential element of a specific name. Lowercase when speaking in general or when using the plural. This also includes when the word city is used before a named place. (Examples: My husband’s brother lives in New York City. He lives in the city of New York. I am not fond of cities.)
County – capitalize when referring to a specific county by name. Lowercase when speaking in general or when using the plural. (Examples: I live in Gadsden County. There are 67 counties in Florida.)
Localities – popular names of localities are capitalized. (Examples: The Gold Coast; the Wheat Belt.)
Public Places – terms designating public places are capitalized when they are essential elements of specific names; however, they are lowercased when they occur after multiple names or when they stand alone. (Examples: Fifth Avenue; the Brooklyn Bridge; the Dorset Hotel; on the bridge; the Dorset and the Drake hotels.)
Regions and Directions – in general, lowercase north, south, east, west, northeast, northwest, etc., when these words indicate compass direction. Capitalize when they designate regions. (Examples: Drive half a mile east. I’m from South Florida. She lives in North Florida. He has a Southern accent. Chicago is in the Midwest. Boston is in the Northeast. Wildfires are common in the Western states. The Southeast is experiencing a prolonged drought. A storm has developed in the South Pacific.)
Topographical Names – capitalize generic terms (channel, lake, mountain) that are essential elements of total names. (Examples: the English Channel; Lake Como; the Blue Ridge Mountains.)
[bookmark: _Toc40343284]Seasons
Names of seasons should not be capitalized. (Examples: The book will be published in the spring. In the summer of 2011, several hurricanes struck the Gulf Coast.)



[bookmark: _Toc40343285]Spelling Standardization
[bookmark: _Toc40343286]Rules for Spelling Healthcare vs. Health Care 
Apply the following rules for when to use the spelling of healthcare or health care:
When used as a modifier, for example healthcare provider, it is one word.
When used as a noun and/or pronoun, as in Agency for Health Care Administration, it is two words.
Usage examples are quality health care (two words); and healthcare quality (one word).
Note: For a list of commonly used standardized words, refer to Appendix D Standardized Words List below.
[bookmark: _Toc40343287]Guide to Punctuation
[bookmark: _Toc40343288]Commas (,)
Use commas to separate items in a series and insert a serial comma (also known as a series comma or Oxford comma) after the last word preceding the and or the or in a list. Refer to examples shown in Exhibit 5‑1: Using Commas to Separate Listed Items below. 
	Write
	Do Not Write

	The flag is red, white, and blue.
	The flag is red, white and blue.

	You can have Coke, Sprite, or tea.
	You can have Coke, Sprite or tea.


[bookmark: _Ref34747153][bookmark: _Toc40343385]Exhibit 5‑1: Using Commas to Separate Listed Items
Do use a comma before the final conjunction in a complex series of phrases, or when it is needed to avoid ambiguity. (Example: The committee approved a bill that will provide sustainable funding to support Florida’s education infrastructure, cut energy taxes for businesses, and provide a tax-free weekend for consumers who purchase energy-efficient appliances.)
Placing commas in compound sentences can be confusing. If the clause that follows the conjunction – and, but, or – can stand alone as a sentence, a comma should be used. Otherwise, do not use a comma.
Do use a comma before including or if the phrase or clause that follows is not essential to the meaning of the sentence (i.e., if the sentence could stand without it). (Examples: No matches, including safety matches, are permitted in checked baggage. Self-defense items, such as mace and pepper spray, are not allowed past security.)
[bookmark: _Toc40343289]Apostrophes (’)
With singular nouns, or with plural nouns that do not end in s, use ’s to show ownership. Note: With some singular nouns ending in s or z, pronunciation would be awkward with the added ’s. In such cases, use only the apostrophe (after the final letter) to form the possessive. Avoid the use of a possessive apostrophe in conjunction with acronyms that end in s. Refer to examples shown in Exhibit 5‑2: Use of Possessive Apostrophes below.
	Write
	Do Not Write

	Quiz’
	Quiz’s

	CMS’
	CMS’s

	AHCA’s
	AHCAs’

	SEAS’
	SEAS’s


[bookmark: _Ref34729832][bookmark: _Ref34747013][bookmark: _Toc40343386]Exhibit 5‑2: Use of Possessive Apostrophes
With plural nouns ending in s or es, add an apostrophe after the final s to show ownership. When pluralizing abbreviations written in capital letters, no apostrophe is needed. Refer to examples shown in Exhibit 5‑3: Pluralizing Abbreviations Written in Capital Letters below.
	Write
	Do Not Write

	five VIPs
	five VIP’s

	six CEOs
	six CEO’s


[bookmark: _Ref34729933][bookmark: _Toc40343387]Exhibit 5‑3: Pluralizing Abbreviations Written in Capital Letters
When pluralizing abbreviations written in lowercase letters, use an apostrophe for clarity. When pluralizing numbers written as figures, no apostrophe is needed. Refer to examples shown in Exhibit 5‑4: Pluralizing Numbers Written as Figures below.
	Write
	Do Not Write

	1990s
	1990’s

	W-2s
	W-2’s

	temperatures in the 20s
	temperatures in the 20’s


[bookmark: _Ref34730099][bookmark: _Toc40343388]Exhibit 5‑4: Pluralizing Numbers Written as Figures
[bookmark: _Toc40343290]Semicolons (;)
A semicolon links two closely related sentences not already joined by a coordinating conjunction (i.e., the words and, but, or, nor, for, so, and yet). (Examples: Some people are good managers; others do not measure up. AHCA will be represented at the 2019 Health Summit; CMS will be represented at the Insurance Consortium in 2020.)
Use semicolons to separate items in a series if any of the items already contain commas. The semicolons help prevent confusion. (Example: Contributors to the action plan were Mr. Tom Matthews, Director of Food Services; Dr. Carol Collins, Chief of Food Distribution; and Ms. Martha Stanfield, Assistant Director of Marketing and Development.)
Use semicolons when numbering a string of points and use the word and before the last point. (Example: Include a summary view of (1) roles included in this audience group; (2) degree of impact; (3) geographic dispersion; and (4) unique training needs/considerations.)
[bookmark: _Toc40343291]Rules for Using Quotation Marks
Use quotation marks around the exact words of a speaker. (Examples: Bob said, “I can’t wait to get back to work.” Mrs. Smith asked, “How long have you been on vacation?” Mr. Taylor shouted, “We can’t operate a business this way!”)
When a quoted sentence stands alone, put the appropriate end mark (period, question mark, or exclamation point) inside the closing quotation mark. Commas and periods always go INSIDE the closing quotation mark.
When a quoted sentence (a statement, a question, or an exclamation) falls at the end of a larger sentence, do not use double punctuation (one mark to end the quotation and another to end the sentence). Choose the stronger mark. (i.e., a question mark is stronger than a period; an exclamation point is stronger than a period or a question mark.)
Example:
I was surprised when the doctor said to me, “your appendix has ruptured, and I am rushing you into surgery now!”
When using parentheses, the end mark should be placed inside the closing quotation mark when the parenthetical element is part of the quotation.
Semicolons and colons always go OUTSIDE the closing quotation mark.
When a quoted statement occurs at the beginning of a sentence, omit the period before the closing quotation mark and use a comma instead. (Example: “I think we should stop talking,” he said.)
[bookmark: _Toc40343292]Using Italics and Boldface in Lieu of Quotation Marks
Do not use quotation marks for specific text, instead put text in italicized font in lieu of quotation marks. For quotations within italicized text, use single quotes. For example: In § 369.22(c), Florida Statutes, for aquatic plant management it states:
A ‘maintenance program’ is a method for the management of aquatic plants in which control techniques are utilized in a coordinated manner as determined by the commission.
Do not use quotation marks for referenced artifact names, use italicized font. (Example: Please refer to the Program Management Plan for further information.
Use italics in lieu of quotation marks for key terms, unfamiliar words, emphasis, or for setting off text from the surrounding context.
A combination of both italics and boldface can be used when writing functional text or directions. (Example: From the Signature tab, click on the Start button and then click on Finish.)
[bookmark: _Toc40343293]Ellipsis (…)
A grammatical ellipsis (sometimes called an omission) is a punctuation mark consisting of three dots. Use an ellipsis when omitting a word, phrase, line, paragraph, or more from material being quoted. An ellipsis saves space or removes material that is less relevant. They are useful in getting right to the point without delay or distraction. In addition, an ellipsis can express hesitation, changes of mood, suspense, or thoughts trailing off. Ellipses can also be used to indicate a pause or wavering in an otherwise straightforward sentence. (Example: I don’t know…I’m not sure.)
[bookmark: _Toc40343294]Hyphens (-)
A hyphen is the shorter mark that is often used to join two words, or parts of words, together while avoiding confusion or ambiguity. (Example: Run-down). Use a hyphen to help avoid confusion with another word. (Example: (1) He was asked to re-sign the petition. Avoids confusion with resign. (2) As part of his latest remodeling project, he wants to re-cover his kitchen floor. Avoids confusion with recover.)
Note: A hyphen never has spaces on either side.
Hyphens are often used between elements of a compound modifier in attributive position to avoid ambiguity. (Example: He is a small-business owner.)
Use a hyphen to avoid duplicated vowels and tripled consonants: (Example: The candidate is accused of being anti-intellectual.)
When a compound modifier precedes a noun, use hyphens to link all the words in the compound except the adverb very and adverbs that end in ly. (Examples: He’s a small-business owner. That’s my long-term plan. Sarah is a very pretty girl. April 15 is a frequently missed deadline.)
The hyphen is used most commonly to combine words (e.g., compounds such as well-being and high-level) and to separate numbers that are not inclusive (e.g., phone numbers and Social Security numbers).
You don’t need to use a hyphen with compound modifiers if the meaning is clear without the hyphen. (Examples: It was an important civil rights case. Per capita spending is up.)
Many combinations that are hyphenated before a noun are not hyphenated when they occur after a noun. (Examples: She has a full-time job. She works full time.) When a modifier that would be hyphenated before a noun occurs instead after a form of the verb to be, the hyphen must usually be retained to avoid confusion. (Examples: The woman is quick-witted. The children are soft-spoken. The actress is well-known.)
When large numbers must be spelled out, use a hyphen to connect a word ending in y to the word following it. (Examples: Forty-six; sixty-three; fifty-five; one hundred seventy-five; two hundred fifty-three; three hundred twenty-seven.)
Hyphenate all spelled-out fractions. (Example: Two-thirds of the employees voted.)
Use a hyphen to represent a span or range of numbers or dates. No spaces are necessary around the hyphen. (Examples: May 1-3, 2018; the 2018-2019 school year.)
[bookmark: _Toc40343295]Dashes ( - )
Dashes can be used to add parenthetical statements or comments, like the use of brackets. The hyphen and dash are sometimes confused because they look so similar, but their usage is different.
When using dashes, you may put a space before and after them. (Examples: You may think he is nice - he isn’t. She might come to the party - you never know.)
[bookmark: _Toc40343296]En Dashes (–) and Em Dashes (—)
The en dash is slightly longer than the hyphen but not as long as the em dash. Use an en dash in lieu of a colon to separate a caption from the associated data.
Put a space on both sides of the en dash. Examples:
Objective #1 – Identify all steps necessary to support the efficient and effective review and acceptance of project deliverables.
Objective #2 – Establish agreement as to the content and layout of the Benefits Realization Plan deliverable.
Use the en dash when meaning to, through, and from. We use it most commonly to indicate a span of time, inclusive dates, and numbers. (Examples: July 9–August 17; pp. 37–59.) For more information and examples refer to Section 2.25.13 Time of Day.
Note: The en dash may have a space before and after when not using as through. (Examples: Paul sang his song terribly – and he thought he was brilliant! 3 a.m. – 6:30 p.m.)
The em dash is the mark of punctuation most of us think of when we hear the term dash regarding a sentence. It is longer than the en dash and significantly longer than the hyphen. We use the em dash to create a strong break in the structure of a sentence. Em dashes can be used like parentheses—that is, to enclose a word, or a phrase, or a clause (as we’ve done here)—or they can be used alone to detach one end of a sentence from the main body. Em dashes are particularly useful in a sentence that is long and complex or in one that has a number of commas within it.
For clarity, use em dashes instead of commas to set off a phrase that itself contains commas. (Example: He listed some of the many restaurants—Sonic, Hardees, McDonalds—where he had failed to find a veggie burger.)
Use em dashes to denote an abrupt change of thought or an emphatic pause. (Example: Two ancient live oaks—I had never seen such grand trees—stood on the courthouse lawn.)
Use an em dash before an author’s name at the end of a quotation. (Example: A person’s a person, no matter how small. — Dr. Seuss
Note: The em dash should never have spaces before or after it. (Example: He’s won the election—granted, there was a low turnout—but he’s won!)
How to Type the En Dash and Em Dash
Our computer keyboards lack individual keys that display either of the en or em dashes. (The symbol above the hyphen is an underline, not a dash.) Before word processing, we had to type an em dash by typing two hyphens. Now, many word processing software programs will automatically turn those two hyphens into an em dash if we correctly leave NO space before or after them. (Example: type the following sequence: word hyphen word space/or punctuation and the two dashes will convert to an em dash.)
For an en dash, when you type the sequence of a word space hyphen space word space/or punctuation and the dash will automatically stretch to an en dash.
You can also choose en and em dashes from a menu of symbols that do not appear on the keyboard. In Microsoft Word, click on the Insert tab (located at the top of your screen next to Home), then from Symbols, click on the Symbol drop-down arrow > More Symbols… > Special Characters and from there you can select the en or em dashes and click Insert.
In any software program that handles text, the em dash can be typed on an enhanced keyboard as Alt 0151—that is, hold down the alternate key and, using the numerical pad on the right side of the keyboard, type the numbers 0151. The en dash can be typed as Alt 0150.
[bookmark: _Toc40343297]Exclamation Points (!)
Avoid using exclamation points. They usually aren’t necessary and can make your writing seem less professional.
[bookmark: _Toc40343298]Periods (.)
Use periods at the end of sentences to indicate a full stop. In accordance with The Chicago Manual of Style, general rule is to use periods with abbreviations that end in a lowercase letter (e.g., p. (page), vol., e.g., i.e., etc., a.k.a., a.m., and p.m.).
Also use periods to punctuate bullet points in a bulleted list when each bullet point is a complete sentence. Don’t use any punctuation if the bullet points are not complete sentences. For more information, see sections 2.16 Standard Rules for Spacing and 2.20 Bullets above.
A note on spacing: Use one space between the period at the end of a sentence and the first letter of the next sentence. Using two spaces after punctuation is an outdated writing method.
[bookmark: _Toc40343299]Slashes (/)
There are two types of slashes: a backslash (\) and a forward slash (/). The backslash is used only for computer coding. The forward slash, often simply referred to as a slash, is a punctuation mark.
The slash (/) is an oblique slanting line stroke in print or writing that is used as a signifier of alternatives/options/choices and often used to represent exclusive or inclusive. It is a best practice to use words instead of a slash.
If a slash is used, there is no space before or after the slash. However, per The Chicago Manual of Style, if one or both of the terms separated by the slash consist of two or more words, a space before and after the slash may aid comprehension, which makes it clear that words beyond the ones immediately surrounding the slash are part of the thoughts being weighed.
Here are the acceptable uses for a slash:
With fractions
In internet addresses (URLs) and pathnames
To signify and/or
In certain phrases like 9/11 and 24/7
With two-year spans (e.g., 1991/92 (instead of an en dash))
With informal dates (e.g., 6/1/11)
In abbreviations (e.g., $7/hour (instead of per) and c/o (instead of a period))


[bookmark: _Toc40343300]Grammar
[bookmark: _Toc40343301]Active Voice
Use Active Voice. Active Voice is when the subject performs the verb of a sentence. The subject should appear in the sentence before the verb. The subject should be the person, place, or thing completing the action of the sentence. For example, “The FX EPMO created the project templates” is Active Voice; “The project templates were created by the FX EPMO” is Passive Voice.
Tips:
Active Voice – noun is the subject.
Passive Voice – noun doing the action is the subject.
[bookmark: _Toc40343302]Contracted Words
Do not use contractions. Contracted words (or contractions) are short words made by putting two words together with the omitted letters in the contraction replaced by an apostrophe (e.g., use they are, do not use they’re).
Contractions should only be used in informal writing, such as letters or emails, or in tables when space is limited.
	Use
	Do Not Use

	cannot
	can’t

	is not
	isn’t

	do not
	don’t


[bookmark: _Toc40343389]Exhibit 6‑1: Examples of Contracted Words (Contractions)
[bookmark: _Toc4586603][bookmark: _Toc40343303]Subject/Verb Agreement
Subject/verb agreement means that both the subject and verb must agree; meaning both need to either be singular or both need to be plural. Basic rule – a singular subject (he) takes a singular verb (is), whereas a plural subject takes a plural verb.
[bookmark: _Toc4586604][bookmark: _Toc40343304]Collective Nouns
Audience, board, class, committee, couple, crowd, family, jury, staff, troop, and other collective nouns (nouns that describe a group) are usually treated as singular if the group is acting as a single unit. (Examples: The class is learning about geology. The Girl Scout troop is going on a camping trip.)
However, collective nouns occasionally take plural verbs when the emphasis is on individual members of the group rather than the whole group. (Examples: After a long exam, the class start their research papers on famous mathematicians. The family are in their beds.)
[bookmark: _Toc4586605][bookmark: _Toc40343305]Companies and Most Other Organizations
Companies and most other organizations are considered singular and take a singular verb and pronoun (it, not they; its, not theirs). (Examples: Ford is on track to produce 6 million vehicles in 2013. Next year it will open three new manufacturing facilities in the United States. Its share of the market is growing.)
[bookmark: _Toc4586606][bookmark: _Toc40343306]Indefinite Pronouns
An indefinite pronoun does not refer to any specific person, thing, or amount. It is vague and not definite. Indefinite pronouns are words that replace nouns without specifying what noun they are replacing.
Treat the following indefinite pronouns as singular: another, anybody, anyone, anything, each, either, everybody, everyone, everything, little, much, neither, nobody, no one, nothing, one, other, somebody, someone, something. (Examples: Everyone is invited to the party. No one was excluded. Someone is ordering the birthday cake. Each of the children is bringing a present. One of the girls is planning to sing.) Remember that words ending in -one, -thing, and -body are singular and that these pronouns all use singular verbs.
When each follows a plural subject, keep the verb plural. (Example: The members each feel their responsibility.)
Use a singular verb when two or more subjects connected by and are preceded by each or every. (Examples: Every jacket, suit, and topcoat is marked for reduction. Each man and woman has responded to our plea for funds.)
The indefinite pronouns both, few, many, others, and several are plural and require plural pronouns (e.g., they, them, their) and they all use plural verbs (e.g., are, have, were). However, all, any, more, most, none, and some can be singular or plural depending on context and emphasis. When one of these pronouns is the subject of a sentence, look at the object of the preposition when deciding which verb to use. If the object of the preposition is plural, use a plural verb. If the object of the preposition is singular, use a singular verb. (Examples: All the girls are dancing in the recital. All the jewelry is expensive. None of the money was missing. Many of them are coming home today. Some of the justices were voicing their opposition.)
[bookmark: _Toc4586607][bookmark: _Toc40343307]Prepositional Phrases
When establishing agreement between the subject and verb, disregard intervening phrases and clauses, including prepositional phrases (except when the subject is all, any, more, most, none, or some, as explained above). Remember, the subject and verb must agree. The object of the preposition should not influence the subject-verb agreement. (Examples: The purchase order for new supplies has not been found. The list of suitable candidates is long. High levels of air pollution are prompting health concerns.)
Read the following sentence without the underlined prepositional phrase to select the correct verb.
· The purchase order for new supplies has not been found.
· The purchase order has not been found.
When a sentence has both a positive and a negative subject, make the verb agree with the positive subject. (Example: Profit and not sales is the thing to keep your eye on.)
Use a singular verb after a phrase beginning with one of or one of the. (Example: One of the reasons for so many wins is great motivation.)
[bookmark: _Toc4586608][bookmark: _Toc40343308]Plural Subject and Singular Predicate Noun (or Vice Versa)
If a sentence has a plural subject and a singular predicate noun (or vice versa), the verb should agree with the subject, not the predicate noun. (Examples: Potatoes are her favorite food. Her favorite food is potatoes.)
[bookmark: _Toc4586609][bookmark: _Toc40343309]Singular and Plural Subjects
If the subject is made up of both singular and plural words connected by or, either/or, neither/nor, or not only/but also, the verb agrees with the nearer part of the subject. Since sentences with singular and plural subjects usually sound better with plural verbs, place the plural subject closer to the verb whenever possible. (Example: Miss Smith or her assistants have the data.)
The expression the number has a singular meaning and requires a singular verb. A number has a plural meaning and requires a plural verb. (Examples: The number of bank offices has increased. A number of our branch offices are located here.)
[bookmark: _Toc4586610][bookmark: _Toc40343310]Subjects Referring to One Person
Use a singular verb when two or more subjects connected by and refer to the same person or thing. (Example: Our secretary and treasurer is Frances Smith.) In addition, use singular verbs when subjects expressing periods of time, amounts of money, or quantities represent a total amount. When these subjects represent a number of individual units, use a plural verb. (Examples: Ten acres is considered a small piece of property. Ten acres were plowed last spring.)
[bookmark: _Toc4586614][bookmark: _Toc40343311]Troublesome Words Usage
[bookmark: _Toc4586613][bookmark: _Toc40343312]That and Which
That and which are not interchangeable.
That is a pronoun used to introduce a defining clause (also called an essential clause or a restrictive clause) and gives information essential to the meaning of the sentence. You do not need a comma before a clause beginning with that. (Example: My bike that has a broken seat is in the garage.) In this example sentence, you understand that the speaker has at least one other bike. Specifically, the bike he’s talking about is distinguished from his other bikes by its broken seat. If you removed the clause that has a broken seat, you would lose the implication that he owns more than one bicycle, and even if you somehow knew about the other bikes, you wouldn’t know which one was in the garage. (Example: Cars that are smaller usually get better gas mileage.)
Which is a pronoun used to introduce a nonrestrictive clause (a clause that is not essential to the meaning of the sentence). In most instances, you need to add a comma before a clause beginning with which. Unlike defining clauses, non-defining clauses (also called nonessential or nonrestrictive clauses) do not limit the meaning of the sentence. You might lose interesting details if you remove them, but the meaning of the sentence wouldn’t change. Sometimes, these phrases are set off by commas. My bike, which has a broken seat, is in the garage. Here, the broken seat is simply a description of the bike in the garage. There’s no implication that the speaker owns more than one bike. (Example: My car, which is green, gets great gas mileage.)
[bookmark: _Toc40343313]Shall and Will
Apply these rules for using shall and will:
Use will when the Agency has the action (i.e., The Agency will…)
Use shall with other entities (i.e., The Vendor shall…)
[bookmark: _Toc40343314]Usage of Similar Words
Check proper usage of similar words such as ensure/insure/assure, as well as affect/effect. See Exhibit 6‑2: Troublesome Words Usage below for the usage and explanation of both similar and troublesome words listed.
[bookmark: _Toc4586615][bookmark: _Toc40343315]How to use These Troublesome Words
	Troublesome Words
	Explanation and Usage

	Accept/Except
	Accept means to agree, to receive, or do. Except means not including.

	Affect/Effect
	Affect is normally used as a verb meaning to influence, change, assume. Effect can be either a verb meaning to bring about or a noun meaning result, impression.
The court’s decision will not affect (change) the precedent. She affects (assumes) an unsophisticated manner. It is essential that we effect (bring about) an immediate improvement. How can we assess the full effect (result) of the new law?

	Age/Aged
	I interviewed a man aged 52 for the job. (NOT: a man age 52) You can collect these benefits at the age of 62. (NOT: at age 62.)

	A lot/Allot
	A lot (two words, not alot) means much of something. Allot is a verb meaning to dispense.

	All right
	Like all wrong, the expression all right should be spelled as two words.

	Already/All ready
	The order had already (previously) been shipped. The order is all ready (all prepared) to be shipped.

	Altogether/All together
	He is altogether (entirely) relaxed and ready to go to sleep. The papers are all together (in a group) on her desk.

	Always/All ways
	She has always (at all times) done good work. We have tried in all ways (by all methods) to keep everyone happy.

	Bring/Take
	Bring indicates motion toward. Take indicates motion away from.

	Capitol/Capital
	Capitol is a building in which the legislative body of government meets. The Capitol is a building in downtown Tallahassee; the dome of the state capitol. Capital can be a noun or an adjective. Tallahassee is the capital of Florida; and capital also can be relating to assets (capital improvements).

	Did/Done
	Do not use a past participle to express the past tense. He was the one who did it. NOT...He was the one who done it.
Nothing has been done about the problem on the fourth floor yet.

	Eager/Anxious
	Both anxious and eager mean desirous, but anxious also implies fear or concern. I’m anxious to hear whether we won the bid. I am eager to hear about your new house.

	Email
	The preferred spelling is email, not e-mail or E-mail.

	Ensure/Insure/Assure
	Ensure means to guarantee an event or condition, to make certain. Insure means to protect against loss. Assure means to give someone confidence and to remove doubt or anxiety; the object of assure should always refer to a person.
Department inspectors ensure the safety of food. By law, you must insure your car. I assured my wife that I loved her.

	Etc./Et cetera
	Use the abbreviation etc. sparingly, if at all. Never use the repetitive etc. The use of etc. is for emphasis. Do not use the long form spelling, et cetera.

	Everyday/Every day
	He will soon master the everyday (ordinary) routine. He has called every day (each day) this week.

	Farther/Further
	Use farther for physical distance. Use further for metaphorical distance. Ten miles is farther than I’d like to walk. I’ll have to give this matter further consideration.

	Follow up/Follow-up
	Follow up is a transitive verb and used to take appropriate action or follow with something similar, related or supplementary; to maintain contact with a person as to monitor the effects of earlier activities or treatments. (Examples: All patients were followed up clinically for four months. The police are following up leads.) Follow-up is a noun and used as the act or instance of following up; something that follows up. (Examples: The surgeon scheduled a follow-up with his patient a week after the surgery. A few days after the story broke, the newspaper printed a follow-up.)

	I/Me
	Correct: Please furnish Mary and me with a copy of your report. (Test: Remove the other person from the subject and read the sentence. Please furnish me with a copy of your report.) Not: Please furnish Mary and I with a copy of your report.

	Imply/Infer
	Imply means to suggest. Infer means to assume, to deduce.

	Into/In to
	Into is a preposition that expresses movement toward something. I walked into the room. In and to should be kept separate when one or both are part of a verb. I came in to see my boss. (To is part of the infinitive to see.) The thief broke in to steal my coin collection. (In is part of the phrasal verb broke in, and to is part of the infinitive to steal.)

	Its/It’s
	Its is a possessive pronoun. It’s is the contraction for it is. The boy’s kite has lost its string. It’s going to rain today.

	Lay/Lie
	Lay, laying, laid means to put or to place. This verb requires an object. (I laid the message on your desk. I will lay the book on your desk.)
Lie, lying, lay, lain means to recline, rest, or stay or to take a position of rest, a reclining position. (He lies in bed most of the day. The letter has lain unanswered for days.)

	Leave/Let
	Leave means to depart or abandon. (Leave me alone.) Let means to permit or allow. (Let me help you.)

	Loose/Lose
	Loose means to set free or not tight. Lose means to be deprived of or to be unable to find.

	Maybe/ May be
	Maybe is an adverb that means the same as possibly or perhaps. May be is a verb phrase that means the same as could be (e.g., might happen or a potential state of affairs).

	Principal/Principle
	Principal means the most important or the head of a school. Principle means a fundamental rule or belief.

	Setup/Set up
	Setup is a noun. (We had a great setup.) Set up is a transitive or intransitive verb. (Set up a scholarship fund for deserving students.)

	Their/They’re/There
	Their is a possessive pronoun. (Their division report is overdue.) They’re is the contraction for they are. (They’re sending a revised report.) There is an adverb. (I will meet you there.)

	To/Too
	To is a preposition. (Please give this to Margaret.) Too is an adverb. (It is too cold in here.)

	Try to/Try and
	Use try to rather than the colloquial try and. (I will try to reschedule the meeting.)

	You’re/Your
	You’re is a contraction for you are. (You’re required to complete your timesheet tomorrow.) Your is a possessive pronoun. (Your taxes are due.)
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[bookmark: _Toc40343317]Appendix A – FX Branding Standards and Identity Guidelines
Embedded below is the FX Branding Standards and Identity Guidelines artifact, which is also located in the FXPR at Florida Health Care Connections > Reference Materials > Category: Graphics, which will provide guidance for using Agency logos.


[bookmark: _Toc40343318][bookmark: _Hlk34823415]Appendix B – Standard Font, Font Color, And Font Size Style Settings
Below are the standard fonts, font colors, and font sizes for MS Word and PowerPoint artifacts. Note: Fonts are already pre-set in the Styles for the associated FX Program templates (refer to Section 2.2.3 Pre-set Template Format Styles above).
MS Word
First-level Header (SECTION 1)
Font – Arial (bold, all caps), font size: 14
Font color (blue) – More Colors > Custom
Color model: RGB
Red: 0
Green: 90
Blue: 170
Second and Third-level Headers (1.1 and 1.1.1)
Font – Arial (bold, small caps), font size: 12
Font color (blue) – More Colors > Custom
Color model: RGB
Red: 0
Green: 90
Blue: 170
Fourth-level Header (1.1.1.1)
Font – Arial (bold, small caps), font size: 11
Font color (blue) – More Colors > Custom
Color model: RGB
Red: 0
Green: 90
Blue: 170
Bullets (list level 1)
Font – Wingdings (n = ), font size: 11
Font color (blue) – More Colors > Custom
Color model: RGB
Red: 0
Green: 90
Blue: 170
Sub-bullets for list levels 2 (>) and 3 (–)
Font – Arial, font size: 11
Font color – More Colors > Custom
Color model: RGB
Red: 0
Green: 90
Blue: 170
MS PowerPoint
While the standard font sizes for slide decks are outlined below, note that when developing an MS PowerPoint presentation, the font size will auto-adjust (shrink) to fit as additional content is added.
Cover (first slide) Title
Font – Myriad Pro (bold), font size: 40
Font color (dark blue) – More Colors > Custom
Color model: RGB
Red: 23
Green: 55
Blue: 94
Cover (first slide) Subtitle
Font – Minion Pro (bold), font size: 32
Font color – black
Second Slide Title (section divider slide)
Font – Myriad Pro (bold), font size: 40
Font color (bright blue) – More Colors > Custom
Color model: RGB
Red: 0
Green: 112
Blue: 192
Content Slide(s) Title
Font – Myriad Pro (bold), font size: 40
Font color (dark blue) – More Colors > Custom
Color model: RGB
Red: 23
Green: 55
Blue: 94
Content Slide(s) Body – text
Font – Minion Pro (bold), font size: 32
Font color – standard black
Content Slide(s) Body – bullets
Font – standard round bullet
Font color (reddish orange) – More Colors > Custom
Color model: RGB
Red: 192
Green: 0
Blue: 0
Content Slide(s) Body – Sub-bullets for levels 2 and 3
Font – default standard increase for level 2 sub-bullet (–) and level 3 sub-bullet (smaller standard round bullet)
Font color (reddish orange) – More Colors > Custom
Color model: RGB
Red: 192
Green: 0
Blue: 0
[bookmark: _Toc40343319]Appendix C – Commonly Used Abbreviations And Acronyms
Use the following common abbreviations and acronyms below (remember to always spell out with first use):
AA – Application Architecture
AHCA – Agency for Health Care Administration
ALM – Application Lifecycle Management
CDM – Conceptual Data Model
CFR – Code Federal Regulations
CMDB – Configuration Management Database
CMS – Centers for Medicare and Medicaid Services
DED – Deliverable Expectations Document
DMP – Data Management Plan
DS – Data Standards
DSS – Decision Support System
EDW – Enterprise Data Warehouse
EPMO – Enterprise Program Management Office
ERDs – Entity-Relationship Diagrams
FFM – Federally-facilitated Marketplace
FLAIR – Florida Accounting Information Resource
FMMIS – Florida Medicaid Management Information System
FX – Florida Health Care Connections
FXPR – FX Projects Repository
HHS – Health and Human Services
HIPAA – Health Insurance Portability and Accountability Act of 1996
IA – Information Architecture
ICM – Information Capability Matrix
IS/IP – Integration Services and Integration Platform
ITN – Invitation to Negotiate
JAD – Joint Application Development
LDM – Logical Data Model
MECT – Medicaid Enterprise Certification Toolkit
MECL – Medicaid Enterprise Certification Life Cycle
MES – Medicaid Enterprise System
MITA – Medicaid Information Technology Architecture
OPB – Office of Policy and Budget
PALM – Florida Planning, Accounting, and Ledger Management
PHI – Protected Health Information
PII – Personally Identifiable Information
QA – Quality Assurance
QC – Quality Control
RAD – Rapid Application Development
RFQ – Request for Quote
ROM – Rough Order of Magnitude
SEAS – Strategic Enterprise Advisory Services
SS-A – State Self-Assessment
TCM – Technical Capability Matrix
[bookmark: _Toc40343320]Appendix D – Standardized Words List
& – always spell out the word and; best practice is not to use ampersands when writing. (Exception is when part of a proper name or acronym.)
Anytime – always one word.
As-is – hyphenated and lowercase.
Backup/back up – noun one word. (Examples: If the files get lost, we have a backup. We have a backup plan.) Intransitive verb/transitive verb two words. (Examples: I will back you up at work. The firefighters needed back up to control the fire.)
Biweekly – one word.
Breadcrumbs – one word.
Bottom-up – hyphenated.
Canceled – this is the correct spelling and has only one l, which is the preferred American English (not cancelled, which is British English). (Note: AP Stylebook recommends canceled.)
Cannot – one word is preferred (see next bullet below for exception).
Can not – two words only when part of some other construction, such as not only or but also. (When in doubt, one word is best.)
Checkbox – one word.
Checklist – one word.
Checkpoint – one word.
Close out – two words.
Close-up – hyphenated and used when referring to at close range, or an intimate view or examination of something.
Current state – two words.
Data set – two words.
Day-by-day – hyphenated.
Decision-making – hyphenated.
Disk, disc – use disk when referring to a computer hard disk or floppy disk, and in medical references (slipped disk). Use disc when referring to farm implements (disc harrow), brakes (disc brakes), phonograph records (disc jockey), and optical and laser-based devices (compact disc, laser disc).
Drop-down – hyphenated in all uses.
Dry run – always two words.
End point(s) – two words.
End-user – hyphenated in all uses and lowercase (i.e., end-user).
Failover – one word.
Follow up/follow-up – follow up is a transitive or intransitive verb. (Example: The police will follow up on the leads.) Follow-up is a noun. (Examples: The newspaper printed a follow-up. The doctor scheduled a follow-up with his patient.)
Framework – one word.
Future state – two words.
Go-Live – hyphenated and both words initial cap.
Gray – preferred word choice in lieu of grey for both color and metaphorical use.
Hard copy – two words.
Home page – two words.
ID – all caps, no periods.
In between – always two words.
Inbound – always one word.
In-depth – hyphenated.
In-line – hyphenated.
In-Sprint – hyphenated and both words initial cap.
Internet – lowercase if referring to a general network of computers; capitalize if reference is as a proper noun (i.e., you are referring to the World Wide Web). 
Intraday – always one word.
IT – all caps, no periods.
Java – always initial cap.
Kickoff/Kick off – Kickoff is a noun and an adjective. (Example: The kickoff time is noon.) Kick off is its corresponding phrasal verb. (Example: The kicker is ready to kick off.) Note: No dash used in any instance.
Life cycle – two words and lowercase. Exception is for ALM where the L for lifecycle is one word.
Life span – two words.
Log in/log on/log off – two words (no hyphen) as verbs (AP style), BUT one word used as nouns.
Login/logon/logoff – login, logon, logoff is each one word when used as nouns, BUT two words (no hyphen) used as verbs (AP style).
Long-term – hyphenated word.
Lookup/Look up – noun one word. (Examples: They wrote a program to do a table lookup. This company’s servers bounced around over the years, including to the U.S., according to domain lookups.) Intransitive verb/transitive verb two words. (Examples: Look up, things are not all bad. Business is looking up. Look up an address.)
Loosely coupled – two words, not hyphenated.
Lowercase – always one word.
Mailroom – one word.
Metadata – one word.
Mock-up – hyphenated word.
Modeling – one L.
Nonfunctional – one word.
No one – two words.
Off-board/off-boarding – hyphenated word.
Onboard/onboarding – one word.
Ongoing – one word.
On-site – hyphenated word.
Online – one word.
Outbound – always one word.
Out-of-state – hyphenated.
Out-weigh – hyphenated.
Overrun – one word.
Placeholder – one word.
Policymaking/policymaker – each instance is one word spelled as compounds per AP Stylebook.
Pop-up – hyphenated word.
Real-time/real time – Real-time is an adjective describing something in which results, feedback, or statistical data follow input with no noticeable delay. Real time, two words, is used where the phrase functions as a noun, usually embedded in the adverbial phrase in real time. Real-time data is data received with no delay, while real time data might be time data that is real. The hyphen in real-time prevents confusion. There is no risk of confusion with phrases such as data in real time, so no hyphen is needed. Or, in simpler terms, remember that real-time usually comes before what it modifies (real-time feedback), while in real time usually comes after what it modifies (we received her feedback in real time).
Requester – not Requestor. (Requestor only for Legal use.)
Role base – two words. 
Role-based – hyphenated word.
Rolling wave – two words.
Round-robin – always hyphenated; always lowercase (i.e., round-robin).
Rule-making – hyphenated word.
Screenshot – one word.
Setback/set back – Setback (noun) is a checking of progress. (Examples: Despite some early setbacks, he eventually became very successful. The colonists persevered despite suffering setbacks that would have discouraged lesser souls.) Set back (verb/transitive verb) is to slow or hinder the progress of (delay). (Examples: She seemed better until her set back. Our house is set back from the road.)
Setup/set up – Setup is a noun. (Example: We had a great setup.) Set up is a transitive or intransitive verb. (Example: Set up a scholarship fund for deserving students.)
Short-term – hyphenated word.
Sign off – two words.
Single sign-on (SSO) – sign-on is hyphenated and all lowercase.
Single sign-off – sign-off is hyphenated and all lowercase (do not use the SSO abbreviation with single sign-off, always spell out).
Skill set – noun and always two words.
Smartphone – one word.
Soft copy – two words.
Stand-alone – hyphenated word.
Startup – one word (according to AP Stylebook).
Statewide – one word.
Step-by-step – hyphenated.
Subcategory/Subcategories – one word.
Sub plan – two words, not hyphenated.
Subprocess – one word, not hyphenated.
Swearing-in – hyphenated.
Timeframe – one word.
To-be – hyphenated and lowercase.
Tool set – two words.
Top-down – hyphenated.
Touchpoint – one word.
Underway – one word in all uses.
Versus – may use approved abbreviation vs. (with period at the end and no italics) or spell out versus.
Walk-through – hyphenated word.
Web service – always two words and web lowercase.
Website – one word; lowercase.
Work-around – hyphenated word.
Workflow – one word.
Work group(s) – two words.
Worksheet – one word.
Workstream – one word, not hyphenated.
World Wide Web – capitalized.

	Agency for Health Care Administration 
	      Page i of 3

	MMIS/DSS/Fiscal Agent Procurement Project
		FX Program Style and Writing Guide	  



	Agency for Health Care Administration 
	      Page 61 of 1

	Florida Health Care Connections (FX)
	FX Program Style and Writing Guide
  


  
image1.png




image4.png
File  Home Inset Draw Design layout  References  Mailings Review  View  Help

AaBbCel SECTIC 1.1 AsB

Delverabl. 1 Delwvera... 1 Deliver.

L 1





image5.emf
Procurement Style  Guide.docx


Procurement Style Guide.docx

image6.emf
SMMC Style  Guide.docx


SMMC Style Guide.docx

image7.png
X

@

[ Ppaste Options:
oG

A Font.. t

=3 Paragraph..

SO Smart Lookup
Synonyms >

5% Tranglate

@ Link >

3 New Comment




image8.png
file  Home Insert Draw  Design  Layout  References

(B

Paste [a
~ <FFormat Painter

Clipboard [ Font [

Arial “n v AA A A
I Uvax x A-2-A-




image9.png
Paste Special

Source: Microsoft Word Document
Microsoft Word Document

as
@paste crosoftWord Document tject Dispayasicon
Pastelink: | Formatted Text (RTF)
Unmates Text
AL Format
Unformatted Unicode Text
el

f Insertsthe contents of the Clpboard as an enhanced metafe.

o]




image10.png
Colors

Standard

Colors:

Color modet:
Red:

Green:

Custom

157

20

Current




image11.png
Colors

Standard

Colors:

Color modet:
Red:

Green:

Custom

RoB
36
165

74

Current




image12.png
Borders and Shading X

Borders  page Border  Shading

Seting sue: preiew
~ Gickon disgram below oruse
= utons t appyborders
—
,,,,,,,,,, . =
Color:
Gid

Custom





image13.png
Colors 70X

Colors: Cancel
Color mogel: |RGB B

Red: 165 %

Green: 166 2

Blue: 166 5

Current




image14.png
Borders and Shading 7 X

Click on diagram below or use.
buttons o apply borders

L





image15.png
Home  Insert

B Add T~
) Update Table

File

Table of
Contents v
Tile of Conens:

Draw  Design  Layout

by Eimerninote

Fen i NetFootnote +

Fooinote 5] ShowNotes
[

Mailngs  Review  View  Help  Acobat

3, BMenage sources

Tvewn | E 1

References

e

) et ableof Figures

Smart Researcher | inert
Lookup Citation v [ Bbliography ¥ | Caption [ cross-reference
e Catons & Bibography Captions.




image16.png
Cross-reference

Reference type: Insert eference to:
Exibit | entire caption

Insert a byperlink Include above/below
Separate numbers with

For which caption:

Exhibit 2-4:Paste As Options Window
Exhibit2-5: Table Header Custom Font Color
Exhibit2-6:Perimeter Table Border Custom Font Color
Exibit 2.7:Perimeter Table Borders

Exibit 2-6: Inside Body of Table Borders Custom Font Color
Exhibit 2-9:Inside Body of Table Borders

Exhibit 2-10: Custom Font Color for Exibit Tites

Location of References and Cross-Reference

‘Exhibit 2-13: Location of References and Insert Caption
Exhibit2-14: Default Caption Window
Exhibit 2-15: New Label Window

[T ]




image17.png
Home  Insert

B Add T~
) Update Table

File

Toble of
Contents v
Tbleof Caments

Draw  Design  Layout

by Bimerninote

Fen i NestFootnote «

Fooinote 5] ShowNotes
Foovors

References

e

Smart Researcher
Lookup

Research

Mailings

Help  Acrobat

[ Manage Sources ) insrt Tobe o Figures

Tsvewn | B 1
Capton EE rossrefcnce
Conrs

Review  View

ot
Chaon+ (D blography~

Ciaions & Bblography




image18.emf

image19.png
Caption
Labet:

Caption: ‘mibﬁ

Figure 1

opions 1 o[ e

Labet:  Figure T

Position: |Below selected tem =

(] Excudelabel trom caption

oo | [y

ButoCaption.. oK. Cancel




image20.emf

image21.emf

image22.emf

image23.png
Object

File name:
[ Browse...
. [ ink to file
" [Doisplayasicon
Result

that you can edit it later using the application which

Inserts the contents of the file into your document so
created the source file.

Cancel





image24.png
Object ?
Create New  Create from File

File name:
it Deliverables and Effort\Graphics for How to Embed Artifacts docx| | growse..

[ uink to file

Result

Inserts an icon that represents the contents of the =
@)= it into your document:

Graphics for How to
Embed Artifacts docx

ok Cancel





image25.png
Change Icon

File name: - CA..\Installer\(90160000-000F-0000-0000-0000000FF 1CE)\wordicon.exe

Icon:

Caption:

Graphics for How to Embed Artifacts docx

oK

Browse..

Cancel





image26.png
o

Graphics for Howto
Embed Artifacts docx




image27.png
Open
Preview
Share
Download
Delete
Rename
Pin to top
Move to
Copy to
Version history
Alert me
More

Details




image28.png
o
Link copied

https://flah harepomt_comlnu

People with existing access can use the
ink

>




image29.png
o

Link copied

People with existing access can use the
link





image30.emf

image31.emf

image32.emf

image33.emf

image34.emf

image35.emf
FX-SEAS-OCM-Brand ing-Standards-Identity-Guidelines-100.pdf


FX-SEAS-OCM-Branding-Standards-Identity-Guidelines-100.pdf
AHCA Florida Health Care
Connections (FX)

FX Branding Standards and Identity
Guidelines

Version: 100

Date: January 20, 2020

Author: Gianna Hernandez, Robby Cunningham

Submitted To: AHCA FX Project Management






FLORIDA HEALTH CARE CONNECTIONS

Revision History

DATE VERSION DESCRIPTION AUTHOR

Gianna Hernandez

12/23/2019 001 FX Branding Standards and Identity Guidelines Robby Cunningham

FX Branding Standards and Identity Guidelines

2/20/2020 100 ) .
approved final version

Carol Williams

Modifications to the approved baseline version (100) of this artifact must be made in
accordance with the Artifact Management Standards (AMS).

Quality Review History

DATE REVIEWER COMMENTS

Proofed, edited and substantially revised from previous
12/23/2019 Robby Cunningham version; original version based upon AHCA'’s branding
standards and identity guidelines from 2012.

1/6/20 Kim Koegel Edited and made content recommendations; incorporated.
1/16/2020 Eric Steinkuehler QC
Agency for Health Care Administration Page ii

AHCA Florida Health Care Connections (FX) FX Branding Standards and Identity Guidelines





Table of Contents

Section 1 Branding StANUAITS ..........ooiiiiiiiiiiie e 1
R G o o [ o T TP 1
A ) QL o3 = I 1 T o 1
1.3 AQENCY COlOIS ..ttt e ettt e e e e e s e e e e e e a e s 3
1.4 MINIMUIM SIZE .ottt e e e e e e e e e s es 3
R O [ Y (=T RO P PP PP TPTPPPPR 4
T W o o To I =0 Y=y o g 1= U [0l od P= Vol =T 0 0 1= o | 4
1.7 USE OF T8 LOGO ...ttt e e e e e eeeas 4
1.8 Use of FX Logo by NON-FX AffilIateS........cccuviiiiiiieeiiiieeeee e 5
1.9  Advertising and PromotiONS............uuiiiiiiiiiiiiiiiiis e e e e e e e e e e e e 5
1.10 EXNiDItS @nd DISPIAYS ....eeeiiiiiiiiiiiiiiiiiie e 5
0 R O 10 1 (= T o ST PR E TP 5
1.12  WHEN 10 USE @ LOGO ... ceeeiiiieiiiiiiiiiee ittt ettt e e et e e e e e e e e eeeas 6

EXNIDit 1-1: FUIL COlOr ..., 2
Exhibit 1-2: ONe-Color BIACK LOGO.......uueiiiieiiiiiiiiii ettt e e e 2
Exhibit 1-3: TWO-COIOr Grey LOQO......ccooeeiieiiieee e 3
Exhibit 1-4: Agency’s OffiCial COIOIS ........ouuiiiiiiii e 3
Exhibit 1-5: Clear Area ArOUNG LOJO .....coieiiiiiiiiiiii et e e et s s s e e e e e e e et e e e e e e e eeaeaanaas 4
EXNIiDIt 1-6: LOGO USAQGE EITOIS ... ..ttt e e e e et e e e e e e e 5
Agency for Health Care Administration Page iii

AHCA Florida Health Care Connections (FX) FX Branding Standards and Identity Guidelines





)
&

SECTION 1 BRANDING STANDARDS
1.1 FXLoco

FX is the acronym for Florida Health Care Connections, which is a series of projects that will be
executed over multiple years and will include updates and improvements to the Agency for
Health Care Administration’s (AHCA or Agency) and related agencies’ technological
transformations. Just as each of these projects and vendors has their own individual identity,
each is an important part of the overall FX identity. In turn, each project’s success and
reputation come, in large part, from its association with FX.

These FX branding standards and identity guidelines were created to protect the overall FX
brand and link all the different projects with the same graphic images and usage, thereof.

The ongoing success and preservation of the FX brand identity depends, in part, upon the
consistent use of the logo. As such, all FX projects and vendors should adhere to these
standards and guidelines.

Any specific questions or comments may be directed to FXProjects@AHCA.MyFlorida.com.

1.2 FXOFFICIAL LOGO

The official logo is the primary visual representation of FX. It is to be used in most situations,
from stationary to signage, templates, and forms. The most straightforward way to create
recognition is to always use the FX logo. The FX official logo presents the name consistently
and thus functions in the same way as a trademark.

The logo is a series of red and blue segments that make up three concentric circles,
surrounding the red and blue overlapping letters FX in the center. Outside of the circle, towards
the bottom of the image, are the words Florida Health Care Connections. The bottom text is in
Myriad Regular, in AHCA blue (see Exhibit 1-4: Agency’s Official Colors). The logo has
been designed with specific dimensions and spacing in order to be easily read and readily
identifiable.

The Full-Color Logo (Exhibit 1-1: Full Color) is the primary logo that shall be used in all
printed and digital applications, except where use of the logo in black, white or grey would be
more appropriate. For example, the Full-Color Logo is to be used on all FX posters, brochures,
templates, presentations, meeting minutes, handouts, the FX Portal, and all other FX-related
products, where possible.

Agency for Health Care Administration Page 1 of 7
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FLORIDA HEALTH CARE CONNECTIONS

Exhibit 1-1: Full Color

The One-Color Black Logo (Exhibit 1-2: One-Color Black Logo) may be used on printed
products that are being provided to stakeholders in black and white or are frequently
reproduced, copied, or reformatted using black ink. Examples include presentations, memos,
meeting minutes, etc. In cases where the other content included in the original document is in
color, the Full-Color Logo should be used. In cases where the additional content is in black and
white, the all-black version should be used.

o
=

X

J

FLORIDA HEALTH CARE CONNECTIONS
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Exhibit 1-2: One-Color Black Logo

The Two-Color Grey Logo (Exhibit 1-3: Two-Color Grey Logo) or the White or Reverse
Logo (Upon request) should be used in situations where the background of the document or
product is a dark color or pattern that would either mask or clash with the Full-Color Logo. For
example, products that use a background color similar to FX Blue should use the White or
reverse Logo, so that the Agency’s logo is prominently displayed against the dark background.
Otherwise, the similar colors of the background and the Full-Color Logo would detract from the
overall aesthetic value of FX’s identity.
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Exhibit 1-3: Two-Color Grey Logo

In all other situations not outlined herein (including where the logo must be resized, such that
text in the cutline would be unreadable), please direct questions or comments to
FXProjects@AHCA.MyFlorida.com.

1.3 AGENCY COLORS

The FX Full-Color logo is composed of the Agency’s official colors, outlined in Exhibit 1-4:
Agency’s Official Colors below:

The Agency'’s official colors are Pantone 072 Blue and Pantone 200 Red. The Agency’s logotypes should
not be reproduced in any other color combinations than these. The logotypes can be reproduced in solid
black or white color when the official colors can not be used or the background interferes with the logo’s
readability.

Blue

PMS 072

CMYK 100, 79, 0,0
RGB O, 79, 162
#004FA2

Red

PMS 200

CMYKO, 100, 65, 15
RGB 205, 16, 65
#CD1041

Pantone 200

Exhibit 1-4: Agency’s Official Colors

1.4 MINIMUM SIZE

To ensure that the logo is always legibly and accurately reproduced, NEVER reproduce the
logo at sizes less than 3/4 inch in diameter.
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1.5 CLEAR AREA

A clear area around the FX logo (Exhibit 1-5: Clear Area Around Logo) will ensure they have
maximum visibility and impact on every communication. Avoid crowding the logo with other
graphic elements such as typography and imagery. As illustrated, 1/8 inch has been chosen as
the standard unit of measurement for the logo clear area.

®

S’

FLORIDA HEALTH CARE CONNECTIONS
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Exhibit 1-5: Clear Area Around Logo

1.6 LoGO POSITION AND PLACEMENT

Consistent placement of the logo will help to ensure brand recognition and a cohesive look
across all media. The FX logo shall be positioned in the top right-hand corner of a document,
opposite the AHCA logo in the top left-hand corner, as seen in the FX Program Templates
document library located in the FX Projects Repository at Florida Health Care Connections >
Templates.

The full-color application of the logo in bottom right is preferred. If the AHCA logo is to be
displayed on the same document, it will take display priority over the FX logo. Therefore, the
ACHA logo can be placed on the top left corner of the document, and the FX logo on the top
right corner. When production or budgetary requirements warrant it, the one-color version may
be used. It shall be positioned in the bottom left corner on the front cover of multi-page
documents or at the bottom of the first page of documents less than two pages long, as
needed.

1.7 USE OF THE LOGO

The FX logo must always be reproduced with consistent high quality. No attempt should be
made to replicate it with art or commercial typography. Always use camera-ready art as
supplied by the AHCA Multimedia Design Unit or pre-approved electronic files provided for
download from the Multimedia Design SharePoint or the FX Projects Repository site.
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Because the size and space relationships of the letters in the logo are part of a strategic design
initiative, it is important to not alter the logo (e.g., outlining, shadows, bold, stretching or
condensing, different spacing, etc.). The consistent and exact reproduction of the FX logo is
essential to maintaining the FX identity. Below are some common logo usage errors (Exhibit

1-6: Logo Usage Errors).

\ FLORIDA mmaumnnxmn; :
FLORIDA HEALTH CARE CONNECTIONS = — - ’

FLORIDA HEALTH CARE CONNECTIONS
FLORIDA HEALTH CARE CONNECTIONS

Improper Resizing Changing Colors Using Graphic Effects Poor Background Contrast

Exhibit 1-6: Logo Usage Errors
1.8 UsSE oF FX LoGO BY NON-FX AFFILIATES

We DO NOT ALLOW the use of the Agency’s logo or the FX logo by organizations not
contractually affiliated with FX. Not only could this be perceived as endorsing private interests
or showing preference to a specific entity, we would also lose branding control and usage. If
you receive a request to use the FX logo from an outside entity and are unsure of their ability to
use the logo under these guidelines, please forward the request to
FXProjects@AHCA.MyFlorida.com.

1.9 ADVERTISING AND PROMOTIONS

All FX-related newspaper, web, magazine, display, television, and any other type of
advertisements and/or external promotional initiatives must carry the FX brand and official logo,
alongside an Agency official logo, as appropriate. The AHCA Communications Office must
approve all FX-related advertisements.

1.10 EXHIBITS AND DISPLAYS

The same logo rules that apply to publications are applied to stand-alone, two-dimensional,
and three-dimensional displays.

1.11 OUTREACH

Outreach is an important means by which the Agency presents itself and its services to key
audiences. FX projects are to coordinate with the Agency to ensure collaboration and unity with
outreach messaging. While consistency of identity and image is paramount in outreach, so is
flexibility and creativity. For that reason, the general design and layout are quite flexible, with
emphasis on the proper use of the FX logo.
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FLORIDA HEALTH CARE CONNECTIONS

1.12 WHEN TO USE A LOGO

MEDIA ITEMS FuLL CoLOR LoGo SINGLE COLOR LOGO

Printed Publications X X
Electronic Media (web, PowerPoint, etc.) X X
Word Processing X X
Video/TV X X
Forms X X
Direct Mail X X
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FLORIDA HEALTH CARE CONNECTIONS

For all inquiries concerning proper use of the FX logo,
please contact EXProjects @AHCA . MyFlorida.com.

Agency for Health Care Administration Page 7 of 7
AHCA Florida Health Care Connections (FX) FX Branding Standards and Identity Guidelines




mailto:FXProjects@AHCA.MyFlorida.com




image2.png




image3.png
i
=
=
=
7
]
=
S
=
[*T]
[

<
o
x
i
=
ekl
x
<
=
e
S
w—l
[~





